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του αίματος εντός αρτηρίας. Η διατομή της αρτηρίας θα είναι κυκλική και κατά μήκος 
αυτής θα παρουσιάζονται στενώσεις, καθώς γίνεται χρησιμοποίηση της 
υπολογιστικής ρευστοδυναμικής πεπερασμένων στοιχείων. Αρχικά, μελετάται η ροή 
σε αρτηρίες δίνοντας προσοχή στους λόγους όπου την καθιστούν ένα βασικό 
αιμοδυναμικό πρόβλημα. Στη συνέχεια, παρουσιάζονται αριθμητικοί υπολογισμοί 
αφορώντας την συγκεκριμένη ροή, καθιστώντας τη βάση για την μελέτη 
αιμοδυναμικών ροών μέσα σε σωλήνες διαφόρων διαμέτρων και στενώσεων, που θα 
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της μελέτης εν συγκρίσει όμως με κλασσικές θεωρήσεις και πειραματικές μετρήσεις. 
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επιστημονικό συνεργάτη του Τμήματος Μηχανολογίας, τόσο για την βοήθειά του όσο 
και για την καθοδήγηση που μας προσέφερε. 
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ΠΕΡΙΛΗΨΗ 
 
 
 

Ένας από τους πιο ανεπτυγμένους τομείς της εφαρμοσμένης έρευνας του 
μηχανικού είναι η Υπολογιστική Ρευστομηχανική και Υπολογιστική Μηχανική των 
ρευστών. Στην παρούσα εργασία πραγματοποιείται μια θεωρητική και πειραματική 
μελέτη σχετικά με τις εφαρμογές της Υπολογιστικής Ρευστομηχανικής καθώς 
πραγματοποιείται μία ανάλυση ροής αίματος εντός αρτηρίας χρησιμοποιώντας το 
πρόγραμμα ICEM και το λογισμικό Fluent. Επιπλέον, πραγματοποιείται μια 
θεωρητική ανάλυση όσο αναφορά θεμελιώδεις σχέσεις εξισώσεων ροής. 
 Το πρώτο κεφάλαιο (Εισαγωγή) αναφέρεται στην γενική περιγραφή του 
αίματος καθώς και σε βασικές ροϊκές ιδιότητες που έχει. Πραγματοποιείται αναφορά 
σε διάφορες γεωμετρίες όπου μπορούν να έχουν οι στενωμένες αρτηρίες και πώς 
αυτές μπορούν να επηρεάσουν την ροή που μελετάται. Επιπλέον, αναλύεται ο 
τρόπος με τον οποίο συμβάλει η υπολογιστική ρευστομηχανική στον τομέα της 
ιατρικής και πως αυτή συμβάλει στην ανάλυση ροών αίματος. 
 Μελετώντας το δεύτερο κεφάλαιο, γίνεται κατανοητή η έννοια του ρευστού 
καθώς και η ιδιότητες που το χαρακτηρίζουν όταν αυτό βρίσκεται σε υγρή, στερεή 
αλλά και αέρια κατάσταση. Γίνεται λόγος για ορισμένες διακρίσεις μεταξύ των 
φάσεων κατάστασης του ρευστού και στα είδη ροών όπου αυτά κατατάσσονται και 
τέλος, γίνεται αναφορά σε διάφορες θεμελιώδης εξισώσεις ροής και σε πολύ 
σημαντικά θεωρήματα.  
 Η θεωρητική ανάλυση ολοκληρώνεται στο τρίτο κεφάλαιο με την λεπτομερής 
αναφορά στις μεθόδους επίλυσης προβλημάτων μέσω του λογισμικού Fluent. Αρχικά 
επιτυγχάνεται εξοικείωση με τις μεθόδους αυτές και στη συνέχεια μελετάται η 
σημασία των υπολογιστικών πλεγμάτων. Μελετάται ακόμη, η σημασία των 
συνοριακών συνθηκών ροής που πρέπει να εισαχθούν για να υφίσταται μια ανάλυση 
ροής καθώς παρουσιάζεται ο τρόπος όπου επιτυγχάνεται η επίλυση προβλημάτων 
ρευστοδυναμικής φύσεως. Τέλος, εφαρμόζοντας μεθόδους παρεμβολής και 
πεπερασμένων στοιχείων, πραγματοποιείται ανάλυση της διαδικασίας 
διακριτοποίησης στο χώρο. 
 Στο τέταρτο κεφάλαιο αναλύεται εκτενώς ένα πρόβλημα ροής όπου γίνεται 
λεπτομερείς ανάλυση ροής αίματος εντός αρτηρίας με διακλάδωση, εφαρμόζοντας τις 
θεωρητικές μελέτες που αναφέρθηκαν στα προηγούμενα κεφάλαια. Η μοντελοποίηση  
της ροής αυτής πραγματοποιείται, χρησιμοποιώντας το πρόγραμμα ICEM. Αρχικά 
παρουσιάζεται ο τρόπος με τον οποίο εισάγεται στο περιβάλλων εργασίας του ICEM 
η αρτηρία και στη συνέχεια παρουσιάζεται η διαδικασία με την οποία 
πραγματοποιείται η πλεγματοποίησή της. 
 Στο πέμπτο κεφάλαιο πραγματοποιείται προσομοίωση ροής εντός μιας 
αρτηρίας. Το κυρίως θέμα της παρούσας εργασίας είναι η μελέτη και η κατανόηση 
του κεφαλαίου αυτού. Η γεωμετρία του υπολογιστικού πεδίου, το πλέγμα και η 
αριθμητική επίλυση των εξισώσεων ροής πραγματοποιήθηκαν με τα προγράμματα 
ICEM, Meshing και Fluent του ANSYS. Ειδικότερα για το Fluent επιλέχθηκε το 
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μοντέλο τύρβης k-ε και πραγματοποιήθηκε έλεγχος για διάφορες τιμές ακρίβειας. Στη 
συνέχεια, φαίνεται με λεπτομερές τρόπο όλη η διαδικασία εισαγωγής των 
συνοριακών συνθηκών και παρουσιάζονται με απλό και κατανοητό τρόπο τα 
αποτελέσματα που προέκυψαν. 
 Μελετώντας την παρούσα εργασία, γίνεται κατανόηση στις μεθόδους που 
χρησιμοποιεί η υπολογιστική ρευστομηχανική σε θεωρητικό αλλά και σε πειραματικό 
επίπεδο. Συμπεραίνουμε ακόμη, ότι εφαρμόζοντας την επιστήμη αυτή μπορούμε να 
καλύψουμε ένα πολύ μεγάλο εύρος προβλημάτων ροής και επιπλέον, μας δίνεται η 
δυνατότητα να προσθέσουμε εναλλαγές στον τρόπο με τον οποίο επιλέγουμε να 
επιλύσουμε το εκάστοτε πρόβλημα. Το παρόν πρόβλημα μας βοηθάει να 
κατανοήσουμε την λογική με την οποία λειτουργεί το λογισμικό Fluent και ICEM και 
πιο συγκεκριμένα μας βοηθά στον χειρισμό προβλημάτων ροής σε αρτηρίες που 
παρουσιάζουν διακλαδώσεις αλλά και στενώσεις, όπως αναφέρεται στο τέταρτο και 
πέμπτο κεφάλαιο αντίστοιχα. 
 



[vii] 

 
 
 
 

ΠΕΡΙΕΧΟΜΕΝΑ 
ΠΡΟΛΟΓΟΣ ...................................................................................................................................................... III 

ΠΕΡΙΛΗΨΗ ....................................................................................................................................................... V 

ΠΕΡΙΕΧΟΜΕΝΑ ............................................................................................................................................... VII 

1 ΕΙΣΑΓΩΓΗ ................................................................................................................................................ 1 

1.1 ΟΡΙΣΜΟΣ ΤΟΥ ΑΙΜΑΤΟΣ................................................................................................................................... 1  
1.2 ΡΟΪΚΕΣ ΙΔΙΟΤΗΤΕΣ ΤΟΥ ΑΙΜΑΤΟΣ ....................................................................................................................... 2  
1.3 ΓΕΩΜΕΤΡΙΑ ΑΡΤΗΡΙΩΝ ΜΕ ΣΤΕΝΩΣΕΙΣ ................................................................................................................. 3  

1.3.1 Είδη στένωσης ................................................................................................................................. 4  
1.3.2 Η επίδραση των στενούμενων αρτηριών ........................................................................................ 5  
1.3.3 Παράμετροι ροής του αίματος ........................................................................................................ 5  

1.4 H ΥΠΟΛΟΓΙΣΤΙΚΗ ΡΕΥΣΤΟΜΗΧΑΝΙΚΗ ΣΤΟΝ ΤΟΜΕΑ ΤΗΣ ΙΑΤΡΙΚΗΣ ............................................................................. 6  
1.4.1 Σύντομη θεωρία .............................................................................................................................. 6  

1.5 ΑΠΕΙΚΟΝΙΣΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ .............................................................................................................................. 7  
1.6 ΣΥΝΟΠΤΙΚΗ ΠΕΡΙΓΡΑΦΗ ΤΗΣ ΕΠΕΞΕΡΓΑΣΙΑΣ ΚΑΙ ΑΝΑΛΥΣΗΣ ΤΗΣ ΕΙΚΟΝΑΣ .................................................................... 8 

2 Η ΕΝΝΟΙΑ ΤΟΥ ΡΕΥΣΤΟΥ ....................................................................................................................... 10 

2.1 ΟΡΙΣΜΟΣ ................................................................................................................................................... 10  
2.2 ΙΔΙΟΤΗΤΕΣ ΤΟΥ ΡΕΥΣΤΟΥ ................................................................................................................................ 10  
2.3 ΣΧΕΣΕΙΣ ΙΞΩΔΟΥΣ ΥΓΡΩΝ ................................................................................................................................ 13  

2.3.1 Τάση ατμών υγρού ........................................................................................................................ 14  
2.3.2 Επιφανειακή τάση ......................................................................................................................... 14  
2.3.3 Τριχοειδή φαινόμενα .................................................................................................................... 15  

2.4 ΕΙΔΗ ΡΟΩΝ ................................................................................................................................................. 16  
2.5 ΕΞΙΣΩΣΕΙΣ ΡΟΗΣ ........................................................................................................................................... 18  

2.5.1 Εξίσωση συνέχειας - Αρχή διατήρησης της μάζας. ....................................................................... 18 
2.5.2 Εξισώσεις ορμής - Δεύτερος νόμος της κίνησης του Νεύτωνα. .................................................... 21 
2.5.3 Εξισώσεις ενέργειας - Αρχή διατήρησης της ενέργειας ................................................................ 23 

3 ΑΝΑΛΥΣΗ ΤΗΣ ΥΠΟΛΟΓΙΣΤΙΚΗΣ ΡΕΥΣΤΟΔΥΝΑΜΙΚΗΣ ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΚΩΔΙΚΑ FLUENT .................. 29 

3.1 ΕΙΣΑΓΩΓΗ ΣΤΟ ΛΟΓΙΣΜΙΚΟ FLUENT ................................................................................................................... 29  
3.2 ΣΥΝΟΡΙΑΚΕΣ ΣΥΝΘΗΚΕΣ ................................................................................................................................. 30  

3.2.1 Συνοριακές συνθήκες εισόδου ταχύτητας .................................................................................... 30  
3.2.2 Συνοριακές συνθήκες εισόδου πίεσης .......................................................................................... 31  
3.2.3 Συνοριακές συνθήκες εξόδου ταχύτητας και πίεσης .................................................................... 31 
3.2.4 Συνοριακές συνθήκες τοιχωμάτων ............................................................................................... 32  
3.2.5 Συμμετρικές συνοριακές συνθήκες ............................................................................................... 32  
3.2.6 Κυκλικές συνοριακές συνθήκες .................................................................................................... 33  
3.2.7 Περιοδικές συνοριακές συνθήκες ................................................................................................. 33  
3.2.8 Αξονικές συνοριακές συνθήκες ..................................................................................................... 34  

3.3 ΔΙΑΔΙΚΑΣΙΑ ΕΠΙΛΥΣΗΣ ΣΤΟ FLUENT ................................................................................................................... 35  
3.4 ΜΕΘΟΔΟΣ ΔΙΑΚΡΙΤΟΠΟΙΗΣΗΣ ΤΩΝ ΠΕΡΑΣΜΕΝΩΝ ΟΓΚΩΝ. .................................................................................... 36  

3.4.1 Γενική περιγραφή της μεθόδου. ................................................................................................... 36  
3.4.2 Διακριτοποίηση πεπερασμένων στοιχείων. .................................................................................. 37  

3.5 ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΤΩΝ ΟΓΚΩΝ ΕΛΕΓΧΟΥ. .......................................................................................................... 38  

4 ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΚΑΙ ΠΡΟΣΕΓΓΙΣΗ ΠΡΟΒΛΗΜΑΤΟΣ ΡΟΗΣ ΑΙΜΑΤΟΣ ΕΝΤΟΣ ΑΡΤΗΡΙΑΣ 
ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΚΩΔΙΚΑ ANSYS ICEM ..................................................................................................... 42 



[viii] 

4.1 ΕΙΣΑΓΩΓΗ. .................................................................................................................................................. 42  
4.2 ΠΡΟΕΤΟΙΜΑΣΙΑ ΠΕΡΙΒΑΛΛΟΝΤΟΣ ΕΡΓΑΣΙΑΣ ICEM ΚΑΙ ΕΙΣΑΓΩΓΗ ΔΕΔΟΜΕΝΩΝ ΑΡΤΗΡΙΑΣ. ............................................. 43 
4.3 ΠΡΟΣΔΙΟΡΙΣΜΟΣ ΤΜΗΜΑΤΩΝ ΑΡΤΗΡΙΑΣ. .......................................................................................................... 43  
4.4 ΔΗΜΙΟΥΡΓΙΑ ΥΛΙΚΟΥ ΣΗΜΕΙΟΥ ........................................................................................................................ 46  
4.5 ΔΗΜΙΟΥΡΓΙΑ ΠΛΕΓΜΑΤΟΠΟΙΗΣΗΣ OCTREE. ..................................................................................................... 48  
4.6 ΔΗΜΙΟΥΡΓΙΑ ΠΛΕΓΜΑΤΟΠΟΙΗΣΗΣ DELAUNAY. .................................................................................................... 55  
4.7 ΚΑΘΟΡΙΣΜΟΣ ΕΠΙΛΥΤΗ ΚΑΙ ΕΙΣΑΓΩΓΗ ΣΥΝΟΡΙΑΚΩΝ ΣΥΝΘΗΚΩΝ. ............................................................................. 58  

5 ΔΗΜΙΟΥΡΓΙΑ ΠΡΟΒΛΗΜΑΤΟΣ ΚΑΙ ΑΝΑΛΥΣΗΣ ΡΟΗΣ ΑΙΜΑΤΟΣ ΕΝΤΟΣ ΑΡΤΗΡΙΑΣ ΜΕ ΣΘΕΝΩΣΗ ( ICEM, 
ANSYS FLUENT) .............................................................................................................................................. 62 

5.1 ΕΙΣΑΓΩΓΗ ΚΑΙ ΣΧΕΔΙΑΣΜΟΣ ΤΗΣ ΓΕΩΜΕΤΡΙΑΣ ...................................................................................................... 62  
5.1.1 Χωρισμός της γεωμετρίας ............................................................................................................. 63  
5.1.2 Δημιουργία εισόδου. ..................................................................................................................... 63  
5.1.3 Δημιουργία εξόδου ....................................................................................................................... 64  
5.1.4 Μετονομασία του αρτηριακού τοιχώματος σε AORTA WALL. ...................................................... 65 
5.1.5 Εξαγωγή καμπύλης από επιφάνειες εισόδου και εξόδου. ............................................................ 65 

5.2 ΔΗΜΙΟΥΡΓΙΑ ΤΟΥ ΥΛΙΚΟΥ ΣΗΜΕΙΟΥ .................................................................................................................. 67  
5.3 ΔΗΜΙΟΥΡΓΙΑ ΤΟΥ “OCTREE MESH”.................................................................................................................. 68  

5.3.1 Καθορισμός κομματιών και δημιουργία πρίσματος. .................................................................... 69 
5.3.2 Εισαγωγή ρυθμίσεων Global Prism ............................................................................................... 70  

5.4 ΡΥΘΜΙΣΕΙΣ ΠΛΕΓΜΑΤΟΠΟΙΗΣΗΣ (MESH) ........................................................................................................... 70  
5.4.1 Εξέταση της πλεγματοποίησης (Mesh) μέσω Cut Plane. ............................................................... 72 
5.4.2 Εξομάλυνση (smoothing) του πλέγματος (mesh). ......................................................................... 73 
5.4.3 Επανέλεγχος διαδικασίας. ............................................................................................................ 75  

5.5 ΚΑΘΟΡΙΣΜΟΣ ΕΠΙΛΥΤΗ .................................................................................................................................. 75  
5.6 ΕΙΣΑΓΩΓΗ ΠΡΟΒΛΗΜΑΤΟΣ ΚΑΙ ΑΝΑΛΥΣΗΣ ΡΟΗΣ ΣΤΟ ΠΕΡΙΒΑΛΛΟΝ ΕΡΓΑΣΙΑΣ ΤΟΥ FLUENT (ANSYS WORKBENCH) ............... 76 
5.7 ΕΙΣΑΓΩΓΗ ΑΡΧΕΙΟΥ ΠΛΕΓΜΑΤΟΠΟΙΗΣΗΣ ΣΤΟ ANSYS WORKBENCH ......................................................................... 78 
5.8 ΠΡΟΣΟΜΟΙΩΣΗ ΑΡΤΗΡΙΑΣ ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΤΗΝ ΕΦΑΡΜΟΓΗ ANSYS FLUENT ........................................................ 79 

6 ΣΥΜΠΕΡΑΣΜΑΤΑ .................................................................................................................................. 88 

6.1 ΑΠΟΤΕΛΕΣΜΑΤΑ ΥΠΟΛΟΓΙΣΤΙΚΗΣ ΚΑΙ ΡΕΥΣΤΟΔΥΝΑΜΙΚΗΣ ΑΝΑΛΥΣΗΣ. ...................................................................... 88 
6.2 ΜΕΛΕΤΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ ΣΤΑΤΙΚΗΣ ΠΙΕΣΗΣ. .................................................................................................... 88  
6.3 ΜΕΛΕΤΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ ΤΑΧΥΤΗΤΑΣ ΡΟΗΣ. ................................................................................................... 89  
6.4 ΜΕΛΕΤΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ ΚΑΤΑΝΟΜΗΣ ΘΕΡΜΟΚΡΑΣΙΑΣ. ................................................................................... 90  
6.5 ΜΕΛΕΤΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ ΔΙΑΤΜΗΤΙΚΩΝ ΤΑΣΕΩΝ. ............................................................................................ 91  

ΒΙΒΛΙΟΓΡΑΦΙΑ ............................................................................................................................................... 93 

 



[1] 

 
 
 
 
1 ΕΙΣΑΓΩΓΗ 
 
 
 
1.1 Ορισμός του αίματος 
 

Αίμα λέγεται το υγρό που κυκλοφορεί στο αγγειακό σύστημα των ανθρώπων 
και των ζώων. Το αίμα μπορεί να χαρακτηριστεί ως ένας ζωντανός ιστός ο οποίος 
είναι απαραίτητος για τη διατήρηση της ζωής. Από την κυκλοφορία του αίματος στις 
φλέβες, στα τριχοειδή αγγεία και στις αρτηρίες εξαρτάτε η σωστή λειτουργία όλων 
των οργάνων του ανθρώπινου σώματος. Με την κυκλοφορία του αίματος στο 
αγγειακό σύστημα εκτελούνται διάφορες λειτουργίες όπως η μεταφορά βιταμινών, 
θρεπτικών ουσιών, ορνονών, θερμότητας και οξυγόνου στους ιστούς, επίσης 
λειτουργεί κατά κάποιο τρόπο και ως καθαριστικό του αγγειακού μας συστήματος 
αφού απομακρύνει από αυτό τις άχρηστες ουσίες που παράγονται κατά τον 
μεταβολισμό και του διοξείδιου του άνθρακα. 

Το αίμα περιλαμβάνει κυτταρικά στοιχεία τα οποία χωρίζονται σε τρεις 
κατηγορίες, τα ερυθρά αιμοσφαίρια, τα λευκά αιμοσφαίρια και τα αιμοπετάλια. Αυτά 
τα τρία συστατικά περιπλανούνται μέσα σε ένα σύνθετο βιολογικό υγρό που 
ονομάζεται πλάσμα. Τα κύτταρα του αίματος μπορούν να ανανεώνονται κατ 
εξακολούθηση από τα αρχέγονα αιμοποιητικά κύτταρα του μυελού των οστών και 
των λεμφικών οργάνων που συμπεριλαμβάνουν τα αιμοποιητικά όργανα. 
 

 
 

Εικόνα 1.1: Κυτταρικά στοιχεία του αίματος 
 
 Το πλάσμα αποτελεί ένα σημαντικό συστατικό του αίματος, αυτό το 
κατανοούμε από το μεγάλο ποσοστό της τάξεως του 55% του όγκου του. Είναι ένα 
διαφανές υποκίτρινο υγρό που αποτελείται από τρία κύρια συστατικά, το νερό, τα 
άλατα και από οργανικές ενώσεις όπως πρωτεΐνες, γλυκόζη, βιταμίνες και ορμόνες. 
Αν δούμε λίγο πιο αναλυτικά τις πρωτεΐνες θα δώσουμε μια ιδιαίτερη σημασία στην 
αιματολογία που έχουν οι παράγοντες του μηχανισμού της πήξης, οι ανοσοσφαιρίνες 
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καθώς επίσης και οι παράγοντες του συμπληρώματος. Το πλάσμα βοηθάει την 
μεταφορά των ηλεκτρολυτών και των διαφόρων θρεπτικών ουσιών στους ιστούς, 
καθώς και την μεταφορά διάφορων ουσιών από το ένα όργανο στο άλλο για 
εξουδετέρωση ή μεταβολισμό. 
 Τα ερυθρά αιμοσφαίρια ή ερυθροκύτταρα είναι απύρηνα κύτταρα που 
περιέχουν αιμοσφαιρίνη από την οποία και προκύπτει και το κόκκινο χρώμα του 
αίματος. Τα ερυθροκύτταρα ανανεώνονται συνεχώς αφού έχουν μέση διάρκεια ζωής 
120 μέρες και αποτελούν ένα σεβαστό ποσοστό της τάξεως του 45% του όγκου του 
αίματος. Η ύπαρξη των ερυθρών αιμοσφαιρίων στο αίμα είναι απαραίτητη για την 
μεταφορά του οξυγόνου ιστούς. Κάτι ακόμα που πρέπει να μάθουμε για 
ερυθροκύτταρα είναι ότι παράγονται στον μυελό των οστών από μια ορμόνη η οποία 
εκκρίνεται στο νεφρό που ονομάζεται ερυθροποιητίνης. 
 Τα λευκά αιμοσφαίρια ή αλλιώς λευκοκύτταρα είναι εμπύρηνα κύτταρα, 
μεγαλύτερα σε μέγεθος από τα ερυθρά αιμοσφαίρια αλλά καλύπτουν ελάχιστο 
ποσοστό στον όγκο του αίματος ο οποίος είναι μόλις το ένα τις εκατό. Επίσης 
ανάλογα με την κατηγορία που ανήκουν αλλάζει και η διάρκεια ζωής τους η οποία 
κυμαίνεται από ένα ή και περισσότερα χρόνια μέχρι και για λίγες μόλις ώρες από την 
δημιουργία τους. Τα λευκοκύτταρα είναι άχρωμα ή έχουν λευκού χρώματος κύτταρα 
με πυρήνα και χωρίζονται σε διάφορες κατηγορίες όπως τα κοκκώδη λευκοκύτταρα, 
τα μεγάλα μονοπύρηνα και τα λεμφοκύτταρα. Η κατηγορία των κοκκωδών 
λευκοκύτταρων διασπάται σε τρία είδη τα οποία είναι τα ουδετερόφιλα, τα 
ηωσινόφιλα και τα βασεόφιλα πολυμορφοπύρηνα. Η κύρια σημασία της ύπαρξης των 
λευκοκύτταρων στον οργανισμό αφορά την εξασφάλιση της άμυνας του και την 
παραγωγή αντισωμάτων για την απομάκρυνση των μικροβίων και πολλών άλλων 
βλαβερών παραγόντων του περιβάλλοντος. 
 Τα αιμοπετάλια είναι απύρηνοι δίσκοι μικρή σε μέγεθος και το σχήμα τους 
μπορούμε να το παρουσιάσουμε και ως ένα μικροσκοπικό πιάτο. Τα αιμοπετάλια 
έχουν σημαντικό ρόλο στην πήξη του αίματος και στην εξασφάλιση της αιμόστασης, 
αφού αυτά είναι η αιτία που δημιουργώντας τον αιμοστατικό αιμοπεταλιακό θρόμβο 
καταφέρνουν να φράξουν το σημείο τραυματισμού ενός αγγείου. Τα αιμοπετάλια 
δημιουργούνται από τον μυελό των οστών και ο μέσος όρος διάρκεια ζωής τους είναι 
μόλις 5 με 10 ημέρες. 
 
 
 
1.2 Ροϊκές ιδιότητες του αίματος 
 
 Το πλάσμα από την φύση του είναι Νευτώνειο ρευστό, αυτό όμως δεν 
σημαίνει ότι και το αίμα θα έχει Νευτώνεια συμπεριφορά. Επίσης αν παρατηρήσουμε 
την σύσταση του ρευστού θα δούμε ότι δεν είναι ούτε ομογενές. Ένα μεγάλο πλήθος 
ερευνητών θεωρούν το αίμα Νευτωνικό ρευστό και ομογενές, αυτή η θεωρία 
βασίζεται στους υψηλούς ρυθμούς διάτμησης που κάνουν έντονη την εμφάνιση τους 
στις μεγάλες αρτηρίες. Σε αυτό το σημείο πρέπει να θέσουμε ένα σημαντικό ερώτημα 
που ακόμη και σήμερα δεν έχει εξασφαλισθεί μια απάντηση απολύτως σωστή, το 
πρόβλημα μας είναι πως μπορούμε να εξασφαλίσουμε με ικανοποιητική προσέγγιση 
ότι το αίμα είναι ένα ρευστό Νευτωνικό και ομογενές για συγκεκριμένα προβλήματα 
ροής. Ωστόσο αυτό έχει μεγάλο ενδιαφέρον αφού αρκετές γνώσεις που έχουμε για 
την δυναμική της ροής του αίματος είχε ως αρχική πηγή ότι το ίδιο το αίμα είχε 
Νευτώνεια συμπεριφορά. Φυσικά σε ακραίες συνθήκες ροής όπου παράγονται 
ασυνήθιστα μεγάλες βαλβίδες ταχύτητας πρέπει να ληφθεί υπ’ όψη η πραγματική μη 
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Νευτώνεια συμπεριφορά του, αυτές τις συνθήκες τις συναντάμε σε κάποια ατυχήματα 
ή ακόμα και κατά την διάρκεια καταδύσεων. 
 Το κύριο κριτήριο στο αν μπορεί με κάποια ικανοποιητική προσέγγιση να 
υποτεθεί Νευτώνεια συμπεριφορά είναι  η γεωμετρία όπως και οι βαθμίδες ταχύτητας 
που κάνουν την εμφανίσει τους σε ένα πρόβλημα ροής. Άλλη μία παρατήρηση που 
μπορούμε να κάνουμε είναι ότι οι ιξωδοελαστικές ιδιότητες του αίματος επηρεάζουν 
τη ρευστοδυναμική συμπεριφορά του. Η γεωμετρία μίας αρτηρίας συμβάλει κατά 
κάποιον τρόπο στο να κατανοήσουμε το πρόβλημα, εφόσον στις μικρές αρτηρίες το 
αίμα δεν μπορεί να θεωρηθεί ομογενές ρευστό επειδή η διάμετρος και η απόσταση 
των ερυθροκύτταρα είναι ανάλογα συγκρίσιμες με την διάμετρο των αρτηριών. 
Φυσικά υπάρχει και η αντίθετη πλευρά στην οποία το αίμα θεωρείτε ομογενές ρευστό 
σε αρτηρίες αρκετά μεγάλες που ξεπερνούν τα 100μm επειδή η κλίμακα της δομής 
του ρευστού είναι αρκετά μικρή σε σχέση με αυτή της ροής. 
 Όπως αναφέραμε και πιο πάνω το αίμα έχει την ιδιαιτερότητα να παρουσιάζει 
Νευτώνεια ή μη συμπεριφορά. Αυτός λοιπόν είναι και ο λόγος  όπου το αίμα 
μοντελοποιείται ανάλογα με το πρόβλημα της ροής του και τις μηχανικές ιδιότητες του 
συστήματος, κάποτε ως Νευτωνικό ρευστό και άλλες φορές ως μη Νευτωνικό. Όταν 
στην ταχύτητα παραμόρφωσης επικρατούν μέτριες τιμές, όπως αυτές που 
παρατηρούνται στην ροή μιας μεγάλης αρτηρίας, η Νευτώνεια συμπεριφορά είναι μια 
ικανοποιητική και συνάμα καλή προσέγγιση. Επίσης μπορεί να χρησιμοποιηθεί και 
σε πιο σύνθετες γεωμετρίες, όπως για παράδειγμα αυτή που καλούμαστε να 
αναλύσουμε στην παρούσα εργασία, στις αρτηρίες με στένωση ή ακόμα και σε 
αρτηρίες με ελλειπτική διατομή. Από επιστημονικές μελέτες που έχουν γίνει για την 
επίδραση της διαμέτρου μιας αρτηρίας (οι μελέτες γίνανε σε σωλήνα για ευνόητους 
λόγους) και του αιματοκρίτη στο ιξώδες του αίματος, γνωρίζουμε ότι το ιξώδες του 
αίματος είναι ανεξάρτητο από την διάμετρο για αρτηρίες με διάμετρο μεγαλύτερη από 
1mm. Αν όμως συναντήσουμε διάμετρο μικρότερη από 1mm τότε η διάμετρος και το 
ιξώδες είναι αλληλένδετα μεταξύ τους και το ιξώδες παρουσιάζει μια μεταβολή μη 
γραμμική με τον αιματοκρίτη. Σε πολλές περιπτώσεις ροής του αίματος οι 
γεωμετρικές διαστάσεις (της διαμέτρου) της ροής είναι μεγαλύτερες από 1mm, κατά 
συνέπεια και το ιξώδες του αίματος θεωρείται ανεξάρτητο της διαμέτρου, υπάρχουν 
όμως και κάποιες περιπτώσεις που δεν ισχύουν τα πιο πάνω όπως είναι τα 
τριχοειδές αγγεία και ο λόγος που δεν ανήκουν σε αυτή την διαδικασία είναι οι 
γεωμετρικές διαστάσεις της ροής. 
 Τέλος, είναι πολύ σημαντικό να αναφερθεί πως τα ερυθρά αιμοσφαίρια έχουν 
μια ποσότητα αιμογλοβίνης. Σε αυτή την ουσία εμπεριέχεται οξείδιο του σιδήρου το 
οποίο θεωρείται στοιχειώδης μαγνήτης. Έτσι το αίμα παρουσιάζει κάποιες ιδιότητες 
μαγνητικού ρευστού με αποτέλεσμα αυτό να επηρεάζει και την τελική ροή του 
αίματος. 
 
 
 
1.3 Γεωμετρία αρτηριών με στενώσεις 
 
 Ένα από τα σημαντικότερα στάδια της υπολογιστικής διαδικασίας είναι ο 
ορισμός της γεωμετρίας. Πρώτου περάσουμε στην διαδικασία να εισάγουμε άλλα 
δεδομένα για τις ιδιότητες και την ροή του ρευστού πρέπει αρχικά να αποφασίσουμε 
ποία γεωμετρία θα ακολουθήσουμε. Οι γεωμετρίες που μπορούμε να 
χρησιμοποιήσουμε μπορεί να είναι είτε δυσδιάστατης είτε τρισδιάστατης μορφής. 
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Στην περίπτωση της αρτηρίας έχουμε εσωτερική ροή οπότε και το υπολογιστικό 
πλέγμα καθορίζετε από τα τοιχώματα της αρτηρίας. 
 
 
1.3.1 Είδη στένωσης 
 
Τα είδη των αρτηριακών στενώσεων διαχωρίζονται σε δύο κατηγορίες: 
 

· Περίπου αξονοσυμμετρική στένωση, Εικ.(1.2). 
·  Ασύμμετρη στένωση, που προεξέχει από το εσωτερικό τοίχωμα σε ένα μέρος 

μόνο της περιφέρειας του αγγείου. (Εικ. (1.3) 
 
 

 
 

Εικόνα 1.2: Αξονοσυμμετρική στένωση, 
 

 
 

Εικόνα 1.3: Ασύμμετρη στένωση, 
 

Στην Εικ.(1.3) φαίνεται η κατανομή της πίεσης κατά μήκους της στένωσης, 
όπου Ρ0 είναι η πίεση ανάντη και Ρ η πίεση κατά μήκους της στένωσης. Όπως 
παρατηρούμε έχουμε μια απότομη πτώση της πίεσης όταν πλησιάζουμε τη στένωση, 
αλλά αυτή ανακτάται αμέσως μετά τη στένωση. 
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Εικόνα 1.4: Τυπική κατανομή πίεσης κατά μήκος της στένωσης, 
 
 
1.3.2 Η επίδραση των στενούμενων αρτηριών 
 
 Η στένωση των αιμοφόρων αγγείων είναι πλέον ένα συχνό φαινόμενο στις 
μέρες μας όπου εμφανίζεται συνήθως μετά την ηλικία των 45 ετών στους άνδρες ενώ 
στις γυναίκες μετά από την ηλικία των 55 ετών. Υπάρχουν φυσικά και κάποιοι 
παράγοντες οι οποίοι μπορούν αθόρυβα να μας κινήσουν τις υποψίες για το 
συγκεκριμένο πρόβλημα όπως η ψηλή αρτηριακή πίεση, η ψηλή χοληστερόλη του 
αίματος και το υπερβολικό σωματικό βάρος. Η στένωση μπορεί να κάνει την 
εμφανίσει της με διάφορους τρόπους όπως για παράδειγμα η ανάπτυξη 
ενδοαρτηριακής πλάκας η οποία έχει ως αποτέλεσμα να κολλάει στο εσωτερικό 
τοίχωμα της αρτηρίας και συνεπώς να αλλάζει και τα γεωμετρικά χαρακτηριστικά της. 
Τα γεωμετρικά χαρακτηριστικά που διαφοροποιούνται είναι το πάχος του 
τοιχώματος, η διάμετρος της αρτηρίας και άλλες πολλές ελαστικές ιδιότητες της 
αρτηρίας. 

Στο σημείο όπου εμφανίζεται η στένωση παρατηρείται και η ελάχιστη πίεση 
αλλά λόγω της απότομης βουτιάς της καμπύλης δεν μπορούμε να διακρίνουμε την 
ακριβή θέση του ελαχίστου. Η γεωμετρία της στένωσης κατέχει σημαντικό ρόλο, 
καθώς η αλλάζει της τιμής της πτώσης πίεσης αλλά και του ελαχίστου είναι πιο 
έντονη στο μοντέλο της ασύμμετρης στένωσης από ότι στο αξονομετρικό μοντέλο. 
Ακόμη μια σημαντική πτώση πίεσης εμφανίζεται ανάντη του λαιμού της στένωσης 
στο αξονομετρικό μοντέλο σε σχέση με το μοντέλο ασύμμετρης στένωσης, παρόλα 
αυτά όσο πιο κοντά πλησιάσουμε προς το λαιμό παρατηρούμε μια μεγαλύτερη 
πτώση πίεσης για το ασύμμετρο μοντέλο. 
 
 
1.3.3 Παράμετροι ροής του αίματος 
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Στην συγκεκριμένη πτυχιακή εργασία θα σταθούμε σε δύο σημαντικές 
παραμέτρους που επηρεάζουν την ροή του αίματος, και αυτές θα αναφέρουμε και θα 
αναλύσουμε στην συνέχεια. 
 

1. Γεωμετρικές παράμετροι: 
 

· Η διάμετρος της αρτηρίας, οποιαδήποτε αλλαγή προκύψει στην διάμετρο φέρει 
ως αποτέλεσμα τις διακύμανσης της ταχύτητας αλλά και της πίεσης. 

· Το πάχος της αρτηρίας, αλλάζοντας το πάχος προκύπτουν αλλαγές στις 
ελαστικές ιδιότητες της αρτηρίας και επίσης μεταβάλλεται και η ταχύτητα 
διάδοσης του κύματος. 

 
2. Αιμοδυναμικές παράμετροι: 

 
· Η ταχύτητα αποτελεί μια από τις πιο σημαντικές παραμέτρους για την 

σύγκριση της ροής. Όπως είναι γνωστό η ταχύτητα είναι αντιστρόφως 
ανάλογη της διαμέτρου, όσο μεγαλύτερη διάμετρο έχουμε τόσο μικρότερη είναι 
η ταχύτητα και το αντίστροφο. 

· Οι διατμητικές τάσεις που ασκούνται στα τοιχώματα αποτελούν και αυτές έναν 
παράγοντα ο οποίος με την σειρά του επηρεάζει στην ροή του αίματος. 

 
Για στρωτή ροή οι διατμητικές τάσεις που ασκούνται στα τοιχώματα 
υπολογίζονται ως εξής. 
 

* ut
y

m
¶

=
¶

r
r

       Εξ.(1.1) 

 
Όπου: μ= δυναμικό ιξώδες 

u= ταχύτητα 
y= απόσταση από το τοίχωμα 

 
Οι διατμητικές τάσεις τοιχωμάτων ορίζονται ως η εφαπτομενική δύναμη που 

ασκείται από το ρευστό που κινείται  στο τοίχωμα του σωλήνα. 
 
 
 
1.4 H Υπολογιστική Ρευστομηχανική στον τομέα της Ιατρικής 
 
 
1.4.1 Σύντομη θεωρία 
 

Η αυξανόμενη ενασχόληση των μηχανικών των διαφόρων ειδικοτήτων τα 
τελευταία χρόνια με την Βιοϊατρική Τεχνολογία προσδίδει μία άλλη οπτική στο 
επιστημονικό αυτό αντικείμενο. Η επίλυση των προβλημάτων της καθημερινότητας 
καθώς και η εφαρμογή των επιστημονικών μεθόδων σε μία επιστήμη που μέχρι 
πρότινος είχε έντονο το στοιχείο της εμπειρίας αποτελεί ένα πεδίο με σπουδαίο 
επιστημονικό ενδιαφέρον. Αυτός είναι και ο λόγος για τον οποίο επιλέχθηκε η μελέτη 
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μίας επεμβατικής τεχνικής ,που πλέον αποτελεί ρουτίνα για την Ιατρική, ωστόσο δεν 
έχει μελετηθεί επαρκώς όσον αφορά στο κομμάτι της ρευστομηχανικής. Η εργασία 
αυτή αποτελεί μία προσπάθεια για διαμόρφωση μοντέλων που θα εξάγουν βασικά 
συμπεράσματα γύρω από την ροή του αίματος σε αρτηρίες και θα προσομοιώσει την 
ροή του αίματος στις στεφανιαίες αρτηρίες μετά από αορτοστεφανιαία παράκαμψη. 
 Με χρήση του υπολογιστικού εμπορικού πακέτου Ansys-Fluent θα μελετηθούν 
διάφορες προτεινόμενες θέσεις και γεωμετρίες. Αρχικά θα μοντελοποιηθούν οι 
διάφορες αυτές γεωμετρίες, θα επιλεγούν οι οριακές συνθήκες στα άκρα των αγγείων 
(συνθήκες πίεσης και παροχής αίματος) και θα εξαχθούν βασικά συμπεράσματα με 
βάση τα αποτελέσματα που θα προκύψουν. 
 
 
 
1.5 Απεικονιστικές Διατάξεις 
 

Πολλές φορές λόγω των πολλών και διαφορετικών διατάξεων που υπάρχουν, 
χρησιμοποιούμε κάποια κριτήρια, για να είναι επαρκής και σωστή η διάγνωση των 
αποτελεσμάτων. Αυτό μπορεί να γίνει με  απεικόνιση της γεωμετρίας (δισδιάστατη,  
τρισδιάστατη). Ακόμη το γεγονός της υψηλής διακριτικής ικανότητας ή όχι αποτελεί 
επίσης κριτήριο επιλογής κατάλληλης μεθόδου. Ακολούθως αναφέρονται οι 
κυριότερες απεικονιστικές διατάξεις που χρησιμοποιούνται ευρέως σε κλινικά 
προβλήματα.  
 

1. Υπολογιστική Τομογραφία CT, MDCT 
2. Μαγνητική Τομογραφία MRI 
3. Ψηφιακή Αφαιρετική Αγγειογραφία DSA, 3DRA 
4. Ενδοστεφανιαίος Υπέρηχος IVUS 
5. Οπτική Συνεκτική Τομογραφία OCT 

 
Η αξονική τομογραφία ή Υπολογιστική τομογραφία (στα Αγγλικά αρχικά Axial 

Tomography, σήμερα Computed Tomography - CT) είναι ακτινολογική μέθοδος 
εξέτασης του ανθρώπινου σώματος. Μπορεί να απεικονίσει σε κάθετες τομές 
ολόκληρο το σώμα, χρησιμοποιώντας την ακτινοβολία Χ. Η υπολογιστική τομογραφία 
παρέχει υψηλή διακριτική ικανότητα και συγκεκριμένα η διακριτική ικανότητα τις 
τεχνικής είναι μεγαλύτερη των 250 μm. Μια τελευταία εξέλιξη της αξονικής 
τομογραφίας είναι η ελικοειδής αξονική τομογραφία (spiral) η οποία, πέρα από άλλα 
πλεονεκτήματα. παρέχει τη δυνατότητα ανακατασκευής των εικόνων, ώστε να έχουμε 
και τομές σε άλλα επίπεδα (μετωπιαία, στεφανιαία και λοξά), πράγμα που μέχρι τώρα 
μόνο η μαγνητική τομογραφία μπορούσε να κάνει. Υπάρχει επίσης η δυνατότητα 
διαμόρφωσης εντυπωσιακών εικόνων τριών διαστάσεων (3D), που βοηθούν πολύ 
στην ορθοπεδική και στην αγγειολογία-καρδιολογία. 

Η Μαγνητική τομογραφία ΜRI μας προσφέρει : 
· Εκμετάλλευση πολλαπλών φυσικών παραμέτρων για τη λήψη φασμάτων και 

μεταβολικών χαρτών υψηλής διαγνωστικής αξίας και στα τρία χωρικά επίπεδα. 
· Αποφυγή επιβάρυνσης του εξεταζόμενου με ιοντίζουσες ακτινοβολίες 

(ακτινοβολίες Χ, γ, β - δυνατότητα επανάληψης χωρίς σημαντικές επιπτώσεις). 
· Τον προσδιορισμό της βιοχημικής σύστασης του οργανισμού με διαδικασίες 

ανώδυνες, με μη επεμβατικό χαρακτήρα.  
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Η μαγνητική τομογραφία, παρότι έχει φέρει νέα επανάσταση στην 
ακτινοδιαγνωστική εμφανίζει και ορισμένα μειονεκτήματα: 

 
· Η αφθονία εφαρμογών και η απαίτηση σύνθετης γνώσης φυσικών 

παραμέτρων, υπολογιστών, μαθηματικών, φυσιολογίας και ανατομίας για την 
σωστή εκμετάλλευση αυτού του εργαλείου καθιστά σχετικά δύσκολη την 
εφαρμογή του. 

· Η μεγάλη χρονική διάρκεια εκτέλεσης ορισμένων ακολουθιών. 
· Η ερμηνεία και η επεξεργασία των εικόνων και των ποσοτικών δεδομένων 

καθώς επίσης και η δυσκολία αναγνώρισης των ψευδενδείξεων. 
· Οι συσκευές που χρησιμοποιούνται στην ιατρική έχουν υψηλό κόστος. 

 
Η ψηφιακή αφαιρετική αγγειογραφία (Digital Subtraction Angiography, DSA) 

είναι μία απεικονιστική εξέταση υψηλής διαγνωστικής ακρίβειας, η οποία καλείται να 
δώσει λεπτομερείς πληροφορίες που αφορούν την αγγειακή ανατομία και 
αιμοδυναμική, με τη χρήση ακτινών Χ και σκιαγραφικού μέσου.Η τεχνολογική εξέλιξη 
συνέβαλλε στη κατασκευή συσκευών (ψηφιακοί αγγειογράφοι), οι οποίες μέσω 
ηλεκτρονικών συστημάτων μετατρέπουν την ακτινογραφία σε ψηφιακή εικόνα. 
Επιπλέον έχουν τη δυνατότητα να αφαιρούν όλα τα υπόλοιπα στοιχεία της εικόνας, 
εκτός από την σκιαγραφική ουσία που εγχέεται ενδοαγγειακά. Η σκιαγραφική ουσία 
ακολουθεί τη φυσιολογική αιματική ροή από της αρτηρίες προς τις φλέβες. Με αυτό 
τον τρόπο παίρνοντας μια σειρά ακτινογραφιών μετά από έγχυση σκιαγραφικού στο 
υπό εξέταση αγγείο, απεικονίζεται αποκλειστικά και με μεγάλη ακρίβεια ο αυλός των 
αγγείων μέσα από τα οποία διέρχεται το σκιαγραφικό. Η διακριτική ικανότητα είναι 
εξίσου υψηλή 100 μm σε 2D, έχει ωστόσο δυνατότητα απεικόνισης και σε 3D με 
3DRA. 

Το ενδοστεφανιαίο υπερηχογράφημα είναι ένα πολύ χρήσιμο εργαλείο τόσο στη       
Διάγνωση-εκτίμηση της σοβαρότητας της στεφανιαίας νόσου, όσο και στην   
αντιμετώπιση της. Έχει υψηλή διακριτική ικανότητα περίπου 50μm, όπως 
παραπέμπει το όνομα της διαδικασίας λειτουργεί με τη χρήση ακουστικών κυμάτων, 
είναι μια επεμβατική μέθοδος. Να σημειωθεί ότι παίρνουμε πληροφορίες για την 
εσωτερική μορφολογία των αγγείων. 

Η οπτική τομογραφία διάχυσης είναι μια πρόσφατη μέθοδος απεικόνισης που 
χρησιμοποιεί φωτόνια κοντά στο φάσμα των υπερύθρων για τον υπολογισμό 
ορισμένων ιδιοτήτων των ιστών και η οποία ανακατασκευάζει τρισδιάστατες εικόνες 
βάση αυτών. Χρησιμοποιεί ακτινοβολία μήκους κύματος λ= 1300nm. Η μέγιστη 
διακριτική ικανότητα είναι 4-16μm, με βάθος απεικόνισης 2-3mm. Είναι σαφές πως 
ανάλογα με τη μέθοδο που θα επιλέξουμε θα εξάγουμε μια γεωμετρική δομή. Οι 
συνοριακές συνθήκες πολλές φορές απορρέουν από μετρήσεις κατά τη διάρκεια μιας 
από τις προαναφερθείσες μεθόδους έτσι πέρα από τη γεωμετρία, προκειμένου να 
μελετηθεί το πρόβλημα ρευστομηχανικά θα πρέπει να γνωρίζουμε τις συνοριακές 
συνθήκες που το διέπουν. 
 
 
 
1.6 Συνοπτική περιγραφή της επεξεργασίας και ανάλυσης της εικόνας 
 

Η ψηφιακή επεξεργασία εικόνων είναι μια σύνθετη διαδικασία επεξεργασίας 
δεδομένων με χρήση υπολογιστή για την επίτευξη συγκεκριμένου στόχου. Είναι η 
υπολογιστική απεικόνιση όπου η εφαρμογή περιλαμβάνει στην οπτική της αλυσίδα 
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τον άνθρωπο. Με άλλα λόγια, οι εικόνες εξετάζονται και χρησιμοποιούνται από 
ανθρώπους. Γι’ αυτούς τους τύπους εφαρμογών χρειάζεται η κατανόηση του τρόπου 
λειτουργίας τους. Η ψηφιακή επεξεργασία των ιατρικών εικόνων περιλαμβάνει στη 
γενικότερη περίπτωση πολλά και διαφορετικά στάδια ανάλογα με τη μορφή και την 
αρχική κατάσταση της ψηφιακής εικόνας και το επιθυμητό τελικό αποτέλεσμα. Έτσι 
θα μας βοηθούσε πολύ να γίνει σε αυτήν τη   διαδικασία χρήση των τεχνικών 
επεξεργασίας σημάτων, ενώ απαιτείται ο συνδυασμός μαθηματικών μεθόδων και 
μοντέλων με αντίστοιχες μεθόδους επίλυσης και ανάπτυξη αντίστοιχου λογισμικού. 
Οι διαδικασίες που αφορούν στην επεξεργασία πολυδιάστατων ιατρικών δεδομένων 
μπορούν συνοπτικά να περιγραφούν με τις επόμενες τέσσερις ομάδες. 
 

1. Προεπεξεργασία: Σε αυτήν την ομάδα οι διαδικασίες χαρακτηρίζονται  
χαμηλού επιπέδου και έχουν ως στόχο τη βελτίωση της ποιότητας 
απεικόνισης των δομών ενδιαφέροντος και περιλαμβάνουν διαδικασίες 
αφαίρεσης θορύβου, εξομάλυνσης, ενίσχυσης ακμών, αλλά και παρεμβολής 
για τη βελτίωση της 3D παρουσίασης δομών ενδιαφέροντος. Η είσοδος στις 
διαδικασίες αυτής της κατηγορίας όπως και το αποτέλεσμα  είναι ένα 
πολυδιάστατο σύνολο δεδομένων . 

2. Εξαγωγή δομών ενδιαφέροντος: Αυτή την ομάδα την χαρακτηρίζουμε 
ενδιάμεσου επιπέδου και έχει ως στόχο τον προσδιορισμό ενός συστήματος 
ανατομικών δομών ενδιαφέροντος. Περιλαμβάνει την εξαγωγή των δομών 
ενδιαφέροντος από τα δεδομένα, την απόδοση ετικέτας και την ομαδοποίηση 
των δομών ενδιαφέροντος. Η είσοδος στις διαδικασίες αυτής της κατηγορίας 
είναι ένα πολυδιάστατο σύνολο δεδομένων όπως επίσης είναι και με το 
αποτέλεσμα ή κάποια άλλη υπολογιστική παραμετρική περιγραφή του 
συστήματος ενδιαφέροντος. 

3. Ανάλυση και αναγνώριση: Οι διαδικασίες αυτής της ομάδας χαρακτηρίζονται 
ως διαδικασίες υψηλού επιπέδου και δίνουν έμφαση στην ποσοτικοποίηση της 
μορφολογικής και λειτουργικής πληροφορίας ενός συστήματος και στην 
ταυτοποίηση συγκεκριμένων δομών με τη βοήθεια κατάλληλης βάσης 
δεδομένων ή «λεξικού», σύμφωνα με τα ποσοτικοποιημένα χαρακτηριστικά. Η 
είσοδος σε αυτές τις διαδικασίες είναι ένα πολυδιάστατο σύνολο δεδομένων 
και το αποτέλεσμα κάποια ποσοτικά χαρακτηριστικά και ταυτότητες δομών 
ενδιαφέροντος. 

4. Μοντελοποίηση: Οι διαδικασίες αυτής της ομάδας χαρακτηρίζονται ως υψηλού 
επιπέδου και σκοπεύουν στη δημιουργία μοντέλων ανατομικών δομών και στη 
καλύτερη δυνατή απεικόνιση και αναπαράσταση της μορφολογίας ή/και της 
λειτουργίας ενός συστήματος αντικειμένων. Η είσοδος σε αυτές τις διαδικασίες 
είναι ένα πολυδιάστατο σύνολο δεδομένων ή κάποια άλλη υπολογιστική 
αναπαράσταση ενός συστήματος αντικειμένων και η έξοδος ένα σύνολο 
εικόνων που αποδίδουν/αναπαριστούν την πολυδιάστατη δομή ή/και τη 
λειτουργία του συστήματος. Μάλιστα, σε αυτές τις διαδικασίες  
περιλαμβάνονται και διαδικασίες διαχείρισης/μοντελοποίησης των δεδομένων 
που αναφέρονται στην εικονική τροποποίηση των αντικειμένων ενός 
συστήματος, όπως π.χ. συμβαίνει κατά την προσομοίωση κάποιας 
χειρουργικής επέμβασης. Η είσοδος σε διαδικασίες διαχείρισης είναι μια 
υπολογιστική αναπαράσταση ενός συστήματος αντικειμένων και το 
αποτέλεσμα είναι η υπολογιστική αναπαράσταση του εικονικά 
τροποποιημένου συστήματος. 
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2 Η ΕΝΝΟΙΑ ΤΟΥ ΡΕΥΣΤΟΥ 
 
 
 
2.1 Ορισμός 
 

Από την εμπειρία μας και μόνο μπορούμε να θεωρήσουμε ως ρευστά τα 
σώματα αυτά που δεν έχουν κάποιο σταθερό σχήμα αλλά έχουν την δυνατότητα να 
ρέουν. Τα ρευστά διακρίνονται σε δύο μεγάλες κατηγορίες, τα υγρά και τα αέρια. 
Φυσικά δεν μπορούμε να μην αναφερθούμε στα λεπτόκοκκα στερεά τα οποία έχουν 
και αυτά ροικές ικανότητες όπως για παράδειγμα η άμμος. Επίσης υπάρχουν και τα 
λεγόμενα «παχύρευστα υγρά» όπου υπό ορισμένες συνθήκες ρέουν με αρκετή 
δυσκολία (π.χ. το μέλι σε χαμηλές θερμοκρασίες). Από την σύγχυση που επικρατεί 
πιο πάνω μπορούμε να πούμε ότι η εμπειρία μας αν και σωστή δεν αρκεί για να 
προσδιορίσει σωστά την έννοια του ρευστού. 
 Με απλούς όρους, ρευστό είναι ένα υλικό το οποίο δεν μπορεί να αντισταθεί 
σε δύναμη διάτμησης (ή σε διατμητική τάση) χωρίς να κινηθεί, όπως συμβαίνει με 
ένα στερεό. Τα ρευστά συνήθως κατηγοριοποιούνται ως υγρά ή αέρια. 
 Ένα υγρό έχει ενδομοριακές δυνάμεις οι οποίες το διατηρούν σε συνοχή έτσι 
ώστε αυτό να κατέχει ένα συγκεκριμένο όγκο αλλά όχι ένα συγκεκριμένο σχήμα. Ένα 
υγρό που χύνεται μέσα σε ένα δοχείο θα γεμίσει το δοχείο μέχρι τον όγκο του, 
ασχέτως του σχήματος του δοχείου. Τα υγρά είναι ελάχιστα συμπιεστά και η 
πυκνότητα τους σχετικά ποικίλει με τη θερμοκρασία και την πίεση. Από την άλλη 
πλευρά ένα αέριο αποτελείται από μόρια σε κίνηση τα οποία συγκρούονται μεταξύ 
τους, τείνοντας να διασκορπίσουν το αέριο. Ένα αέριο δεν έχει καθορισμένο σχήμα ή 
όγκο και θα γεμίσει οποιοδήποτε δοχείο στο οποίο θα εισαχθεί. 
 
 
 
2.2 Ιδιότητες του ρευστού 
 
 Πιο κάτω θα κάνουμε μια γενική ανασκόπηση στις μηχανικές ιδιότητες ενός 
ρευστού. Αναλυτικά οι μηχανικές ιδιότητες των ρευστών και οι ορισμοί τους είναι οι 
εξής. 
 

1) Πυκνότητα 
i) Ειδικό βάρος 
ii) Ειδικός όγκος 
iii) Μέτρο ελαστικότητας 
iv) Μέτρο συμπιεστότητας 

2) Ιξώδες 
i) Κινηματικό ιξώδες 
ii) Σχέσεις ιξώδους υγρών 

3) Πίεση ρευστού 
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4) Τάση ατμών υγρού 
5) Επιφανειακή τάση 
6) Τριχοειδή φαινόμενα 

Πυκνότητα ρ ενός ρευστού είναι ο λόγος της μάζας του ρευστού, m, ανά την 
μονάδα όγκου το ρευστού, V, που καταλαμβάνει αυτή στο χώρο. Ο λόγος αυτός 
ισχύει μόνο στην περίπτωση ομοιόμορφης κατανομής της μάζας του ρευστού, σε 
αντίθετη περίπτωση ο λόγος m/V θα εκφράζει μία μέση πυκνότητα του ρευστού. Η 
μαθηματική εξίσωση που εκφράζει την πυκνότητα ενός ρευστού είναι η εξής: 
 

 
0

lim *( )
V V

m
Vd d

d
r

d®
=       Εξ.(2.1) 

 
όπου: m=μάζα 

V=όγκος 
 

 Οι μονάδες μέτρησης της πυκνότητας στο διεθνές σύστημα είναι kg/m3. 
 
 Ειδικό βάρος γ ορίζεται ως ο λόγος του βάρους του ανά μονάδα όγκου του 
ρευστού και εκφράζεται από τον τύπο: 
 

, 
* gg r=         Εξ.(2.2) 

 
όπου: ρ= η πυκνότητα του σώματος 
 g= η επιτάχυνση της βαρύτητας 
 
Οι μονάδες μέτρησης του ειδικού βάρους στο διεθνές σύστημα είναι N/m3. 
 Ο ειδικός όγκος ν ενός ρευστού (Εξ.(2.3)) είναι αντιστρόφως ανάλογος της 
πυκνότητας του, και εκφράζεται από την σχέση: 
 

 

1v
r

=
         Εξ.(2.3) 

 
όπου: ρ= η πυκνότητα του σώματος 
 
Οι μονάδες μέτρησης του ειδικού όγκου στο διεθνές σύστημα είναι: m3/kg. 
 Η πυκνότητα των ρευστών εξαρτάται κυρίως από την πίεση και την 
θερμοκρασία του σώματος. Το μέτρο συμπιεστότητας και ο συντελεστής κυβικής 
διαστολής παρουσιάζει την εξάρτηση αυτή με τα πιο πάνω μεγέθη.  
 Μέτρο συμπιεστότητας k ονομάζομε την ιδιότητα των σωμάτων να μειώνουν 
τον αρχικό τους όγκο όταν τους ασκούνται πιέσεις. Το μέτρο συμπιεστότητας 
εκφράζεται από την πιο κάτω σχέση: 
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όπου: (θρ/ρ)= η σχετική μεταβολή της πυκνότητας (αδιάστατο μέγεθος) 
Άρα οι μονάδες μέτρησης του μέτρου συμπιεστότητας στο διεθνές σύστημα είναι: 
Pa-1 = (m2/N). (διαστάσεις αντίστροφες της πίεσης) 
 Το μέτρο ελαστικότητας Ε είναι αντίστροφο του μέτρου συμπιεστότητας για 
ένα υλικό. Συνεπώς η σχέση που το εκφράζει είναι: 
 

 

1
k

E =          Εξ.(2.5) 

 
Οπότε έχει διαστάσεις πίεσης και οι μονάδες μέτρησης του στο διεθνές σύστημα 
είναι: Pascal (Pa) 
 Το ιξώδες μ, είναι εκείνη η ιδιότητα των ρευστών η οποία τους δίνει την 
δυνατότητα να φέρει αντίσταση σε κάθε προσπάθεια που γίνεται για την αλλαγή της 
μορφής τους. Αν μπορούσαμε να παρομοιάσουμε το ιξώδες με κάποιο μέγεθος της 
μηχανικής αυτό θα ήταν η τριβή η οποία αντιστέκεται στην μετακίνηση ενός σώματος. 
Η ιδιότητα αυτή του ιξώδες, καθορίζεται από την παραμόρφωση ή διάτμηση των 
ρευστών η οποία προκύπτει από την επίδραση της διατμιτικής τάσης, τ=F/A , όπου F 
η διατμητική δύναμη που δέχεται το ρευστό κατά μήκος της επιφάνειας του και Α το 
εμβαδόν της επιφάνειας του ρευστού. Επίσης για τα αέρια και για ένα μέρος των 
υγρών η διατμητική τάση είναι ευθέως ανάλογη ως προς το ιξώδες του ρευστού. 
Αυτά τα ρευστά που ανήκουν σε αυτή την κατηγορία ονομάζονται Νευτώνεια. Για τα 
ιξώδες Νευτωνικά ρευστά θα αναφερθούμε πιο αναλυτικά στην συνέχεια της 
πτυχιακής μας με την βοήθεια του εξισώσεων Navier-Stokes. Η σχέση η οποία 
χρησιμοποιείτε για τον υπολογισμό του ιξώδες είναι η εξής: 
 

 
* dy

du
m t æ ö= ç ÷

è ø         Εξ.(2.6) 

 
Οι συνήθεις μονάδες μέτρησης του ιξώδες (Εξ.(2.6)) στο διεθνές σύστημα είναι Pa*s 
= N*(s/m2) = kg/(m*s) Ακόμα μια μορφή μονάδος που αποδίδεται στο ιξώδες είναι το 
poise (P). Η σχέση που ενώνει το Pa*s με το poise είναι: 1poise=0,1Pa*s. Επίσης 
1cP=10-3Pa*s .  
 Η τελευταία μορφή μονάδος μέτρησης είναι ιδανική για την παρούσα πτυχιακή 
γιατί μπορούμε να συνδυάσουμε της μονάδες αυτές με την θερμοκρασία του αίματος. 
Η αναλογία της θερμοκρασίας του αίματος με το ιξώδες σε Pc είναι: 37οC είναι 3-4 
cP. 
 Κινηματικό ιξώδες ενός ρευστού (Εξ.(2.7))είναι ο λόγος του ιξώδες ως προς 
την πυκνότητα του και εκφράζεται ως εξής: 
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v m
r

æ ö
= ç ÷

è ø          Εξ.(2.7) 

 
Οι μονάδες μέτρησης του κινηματικού ιξώδες στο διεθνές σύστημα είναι: (m2/s) 
Ακόμη μια μορφή μονάδας μέτρησης του κινηματικού ιξώδες είναι αυτή του stokes 
St, όπου 1 St = 1 cm2/s =10-4 m2/s . 
 
 
2.3 Σχέσεις ιξώδους υγρών 
 
 Το ιξώδες των υγρών μπορεί να υπολογιστεί με την πιο κάτω μαθηματική 
σχέση: 
 

 
0 0

exp a a
b T b T

m
m

é ùæ ö æ öæ ö= -ê úç ÷ ç ÷ç ÷+ +è øè ø è øë û
    Εξ.(2.8) 

  
όπου: μ0= το ιξώδες του υγρού  
 Τ0= η θερμοκρασία του υγρού (συνήθως Τ0=273οΚ) 
 a, b= χαρακτηριστικές σταθερές του υγρού 
 
Τα κορεσμένα υγρά συμπεριλαμβάνονται σε μια άλλη σχέση (Εξ.(2.9)) για τον 
υπολογισμό του ιξώδους η οποία είναι η εξής: 
 

 
1 2log a bT cT dTm -= + + +      Εξ.(2.9) 

 
όπου: a, b, c, d =χαρακτηριστικές σταθερές του υγρού 
 
 Η μεταβολή του ιξώδες ενός ρευστού επηρεάζεται περισσότερο από τη 
θερμοκρασία και λιγότερο από την πίεση. Το ιξώδες των αερίων αυξάνεται με την 
αύξηση της θερμοκρασίας ενώ στα ρευστά το ιξώδες ελαττώνεται με την αύξηση της 
θερμοκρασίας. 
 Πίεση P ενός ρευστού ορίζεται ως η κάθετη τάση που εξασκείται από το 
ρευστό σε μια επιφάνεια. Η πολύ γνωστή σχέση που χρησιμοποιείται για τον 
υπολογισμό της πίεσης είναι: 
 

 0
lim *

dA

dFP
dA®

æ ö= ç ÷
è ø       Εξ.(2.10) 

 
Όπου: F= κάθετη δύναμη 
 Α= επιφάνεια  
 
Η πίεση μετριέται σε Pascal: Pa =N/m2. 
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2.3.1  Τάση ατμών υγρού 
 

Τάση ατμών ενός υγρού ορίζεται ως η πίεση ισορροπίας ενός ατμού επάνω 
από το υγρό της δηλαδή η πίεση του ατμού που είναι αποτέλεσμα της εξάτμισης ενός 
υγρού επάνω από ένα δείγμα υγρού σε ένα κλειστό δοχείο. Επειδή ο πιο πάνω 
ορισμός δεν είναι τόσο σαφής θα ήταν πιο κατανοητό αν το βλέπαμε σε μια εικόνα, η 
πιο κάτω Εικ.(2.1) μπορεί να βοηθήσει στην κατανόηση: 
 

 
 

Εικόνα 2.1: Τάση ατμών υγρού 
 
 Η θερμοκρασία έχει κύριο ρόλο στην τάση των ατμών ενός υγρού. Σε υψηλές 
θερμοκρασίες τα μόρια αναπτύσσουν αρκετή ενέργεια που τους βοηθάει να 
δραπετεύσουν από το υγρό. Ενώ σε χαμηλές θερμοκρασίες η ενέργεια που έχουν τα 
μόρια δεν είναι αρκετή για να διαφύγουν από το υγρό. 
 
 
2.3.2 Επιφανειακή τάση 
 

Επιφανειακή τάση Γ ορίζεται ως μία δύναμη F η οποία ασκείται από την 
επιφάνεια ως προς την μονάδα μήκους l του ρευστού. Αυτό που φαίνεται και πιο 
κάτω (Εικ.(2.2)) όταν ένα μόριο βρίσκεται στο εσωτερικό ενός υγρού υφίσταται 
ελκτικές δυνάμεις από τα υπόλοιπα μόρια που το περιβάλλουν από όλες τις 
διευθύνσεις και έτσι το συνολικό διανυσματικό άθροισμα των δυνάμεων αυτών είναι 
μηδέν. Αντίθετα με τα μόρια που βρίσκονται στην επιφάνεια του υγρού ελκύονται από 
τα μόρια που είναι βυθισμένα στο υγρό με αποτέλεσμα να ασκείται μια συνιστώσα 
δύναμη κάθετη στην επιφάνεια προς το εσωτερικό του υγρού διάφορη του μηδενός. 
Κατά συνέπεια τα μόρια που βρίσκονται στο εσωτερικό του ρευστού πρέπει να 
δαπανηθεί έργο ώστε να μετακινηθούν προς την επιφάνεια. Αυτό μας δίνει την 
δυνατότητα να καταλάβουμε ότι υπάρχει περισσότερη ενέργεια στα επιφανειακά 
μόρια από ότι στα εσωτερικά. 
 Οπότε για την επιφανειακή τάση ενός υγρού μπορούμε να πούμε ότι είναι το 
έργο που χρειάζεται να δαπανηθεί ώστε να γίνει η μεταφορά των εσωτερικών μορίων 
του προς την επιφάνεια, με την προοπτική της αύξησης του εμβαδού της επιφάνειας 
κατά μία μονάδα.  
 



[15] 

 
 

Εικόνα 2.2: Αλληλεπίδραση μορίων 
 
 Η μαθηματική σχέση (Εξ.(2.11)) η οποία χρησιμοποιείται για τον υπολογισμό 
της επιφανειακής τάσης είναι: 
 

F
I

G =          Εξ.(2.11) 

 
 
2.3.3 Τριχοειδή φαινόμενα 
 

Τριχοειδή φαινόμενα ονομάζουμε εκείνη την ικανότητα που έχουν τα υγρά να 
διαβρέχουν ένα συγκεκριμένο υλικό. Ένα υγρό από το οποίο παρατηρείται 
συνηθέστερα το τριχοειδή φαινόμενο είναι το νερό όπου εξαιτίας του ότι έχει τη 
δυνατότητα να συνάψει ισχυρές δυνάμεις συνάφειας με άλλες επιφάνειες και αυτό 
υπάρχει άφθονο στη φύση. Αυτά τα φαινόμενα έχουν πρακτική σημασία όταν η 
διάμετρος του σωλήνα που χρησιμοποιούμε είναι μικρότερη από 10 mm. Η πτώση 
αλλά και η άνοδος του υγρού σε έναν τριχοειδή σωλήνα προκύπτει από την 
επιφανειακή τάση και εξαρτιέται από τα σχετικά μεγέθη συνοχής του υγρού και 
συνάφειας του με τα τοιχώματα του δοχείου όπου περιέχεται. Το ύψος της στάθμης 
του υγρού εντός του τριχοειδή σωλήνα υπολογίζεται από την πιο κάτω μαθηματική 
σχέση: 
 

 
cos2* * *g*rH q

s
r

=
      Εξ.(2.12)

 

 
Όπου: h = το ύψος της στάθμης του τριχοειδή σωλήνα 
 σ = η επιφανειακή τάση 
 θ = η γωνία επαφής 
 ρ = η πυκνότητα 
 g = η επιτάχυνση της βαρύτητας 
 r = η ακτίνα σωλήνα  
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2.4 Είδη ροών 
 

Η ταξινόμηση των μελετώμενων ροών αναλόγως της χώρο-χρονικής 
μορφολογίας του πεδίου ροής φαίνεται παρακάτω στην Εικ.(2.3): 

 

 
 

Εικόνα 2.3: Κατάταξη ροών. 
 
 

Πραγματικό (ιξώδες) ορίζεται ως το ρευστό που το ιξώδες του είναι άνισο του 
μηδενός. Ακόμη δεν έχει βρεθεί κάποιο ρευστό που να μην παρουσιάζει ιξώδες 
συμπεριφορά. Ιδανικό (ανιξώδες) ορίζεται ως το ρευστό που το ιξώδες του είναι ίσο 
με το μηδέν. Επειδή αυτό δεν ισχύει για κανένα ρευστό, ιδανική ροή ονομάζουμε την 
ροή στην οποία η τιμή του ιξώδες είναι αμελητέας σημασίας. 

Στρωτή ροή ονομάζεται εκείνη η ροή που παραμένει ομαλή σε όλο το μήκος 
της και δεν παρουσιάζει έντονες διακυμάνσεις. Αυτό το είδος ροής εμφανίζεται 
σπάνια και το συναντάμε στα ρευστά που έχουν μεγάλο ιξώδες (Re<500) και μικρές 
ταχύτητες. Τυρβώδη ροή ονομάζεται εκείνη η ροή που τα σωματίδια της κινούνται 
σε ασύμμετρες και ακανόνιστες τροχιές. Η τυρβώδη ροή είναι πιο συχνό φαινόμενο 
και εμφανίζεται με αριθμό Reynolds (Re>2000). Ο αριθμός Reynolds υπολογίζεται 
από την σχέση: 
 

 Re 4 Ur
v

=        Εξ.(2.13) 

 
όπου: r = ακτίνα υγρής διατομής 

U = ταχύτητα ροής 
ν = κινηματικό ιξώδες του νερού 
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Μόνιμη ροή ονομάζεται η ροή ενός ρευστού που δεν παρουσιάζει καμία 
μεταβολή σε συνάρτηση με τον χρόνο. Μεταβατική ροή ονομάζεται η ροή που 
δέχεται αλλαγές με την πάροδο του χρόνου. 

Ασυμπίεστη ροή ονομάζεται η ροή του ρευστού στην οποία οι μεταβολές της 
πυκνότητας σε όλη την έκταση του πεδίου είναι αμελητέες, δηλαδή: 
 

 0nD =          Εξ.(2.14) 
 

Συμπιεστή ροή ονομάζεται η ροή του ρευστού στην οποία οι μεταβολές της 
πυκνότητας σε όλη την έκταση του πεδίου είναι σημαντικές. Χρησιμοποιώντας τον 
αριθμό Mach (NMa) μπορούμε να ελέγχουμε πότε μια είναι συμπιεστή και πότε όχι, η 
μαθηματική σχέση είναι η εξής: 
 

Ma
UN
C

=          Εξ.(2.15) 

 

Όπου: U = η χαρακτηριστική ταχύτητα της ροής 
C = η ταχύτητα του ήχου του ρευστού 
 

Αν NMa<= 0,3 , η ροή είναι ασυμπίεστη 
Αν NMa > 0,3 , η ροή είναι συμπιεστή 
 

Ομοιόμορφη ροή ονομάζεται η ροή όπου οι μεταβλητές της είναι ανεξάρτητες 
από τον χρόνο για κάποια χρονική στιγμή. Συνεπώς οι μεταβολές της πυκνότητας 
είναι συνεχής και η κλίση της πυκνότητας του ρευστού ίση με μηδέν. Ανομοιόμορφη 
ροή ονομάζεται η ροή όπου οι ιδιότητες του ρευστού δεν είναι ομοιόμορφες μέσα και 
έξω, άρα και η μεταβολή της πυκνότητας δεν είναι συνεχές. Μονοδιάστατη ροή 
ονομάζεται η ροή στην οποία η ταχύτητα του ρευστού μεταβάλλεται ως προς μία 
χωρική συντεταγμένη, u=u(x,t). Δισδιάστατη ροή ονομάζεται η ροή στην οποία η 
ταχύτητα του ρευστού μεταβάλλεται ως προς δύο χωρικές συντεταγμένες, u=u(x,y,t). 
Τρισδιάστατη ροή ονομάζεται η ροή στην οποία η ταχύτητα του ρευστού 
μεταβάλλεται ως προς τρεις χωρικές συντεταγμένες u=u(x,y,z,t). Εσωτερική ροή 
ονομάζεται η ροή η οποία περιβάλλεται από στερεά όρια, όπως για παράδειγμα η 
ροή μέσα σε αγωγό. Εξωτερική ροή ονομάζεται η ροή η οποία δεν περιορίζεται από 
στερεά όρια και μπορεί να εξαπλωθεί, όπως για παράδειγμα η ροη του αέρα γύρω 
από ένα κτήριο. 
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2.5 Εξισώσεις ροής 
 

Για την μελέτη της κίνησης του ρευστού στον κλάδο της ρευστοδυναμικής, 
χρησιμοποιούμε τέσσερις βασικούς νόμους, όπου αναφέρονται πιο κάτω ονομαστικά 
και ακολούθως αναλυτικά: 

1. Διατήρησης της μάζας (εξισώσεις συνέχειας) 
2. Δεύτερος νόμος της κίνησης του Νεύτωνα (εξισώσεις ορμής) 
3. Διατήρησης της ενέργειας – πρώτος νόμος της θερμοδυναμικής (εξισώσεις 

ενέργειας) 
4. Δεύτερος νόμος της θερμοδυναμικής 

Οι πιο πάνω νόμοι έχουν την δυνατότητα να εφαρμοστούν σε μια δεδομένη 
ποσότητα ύλης (σε ένα σύστημα) η οποία καθώς αλλάζουν οι συνθήκες διατηρεί την 
ταυτότητα της. Εφαρμόζοντας τους νόμους αυτούς σε ένα στοιχείο της ροής ρευστού 
σώματος θα προκύψουν οι κατάλληλες μερικές διαφορικές εξισώσεις για την μελέτη 
της κίνησης ενός ρευστού. Συγκεκριμένα για την αρχή διατήρησης της μάζας 
προκύπτει μια μερική διαφορική εξίσωση που είναι γνωστή ως εξίσωση της 
συνέχειας. Από την εφαρμογή του δεύτερου του Νεύτωνα προκύπτουν τρείς 
εξισώσεις ορμής και αντίστοιχα από τον πρώτο νόμο της θερμοδυναμικής, δηλαδή 
την αρχή διατήρησης της ενέργειας προκύπτει μία εξίσωση η οποία καλείται ως 
εξίσωση της ενέργειας. Ο δεύτερος νόμος της θερμοδυναμικής δεν θα μας 
απασχόληση στη παρούσα πτυχιακή άσκηση διότι αυτός ο νόμος χρησιμοποιείται 
ιδιαίτερα στη ροή των αερίων. 

Στην συνέχεια θα παρακολουθήσουμε την ανάπτυξη των ολοκληρωτικών 
εξισώσεων της κίνησης του ρευστού. Η παρουσίαση της εξαγωγής των εξισώσεων 
θα γίνει με την εφαρμογή τους στις πραγματικές καταστάσεις με σκοπό όσο τον 
δυνατόν την καλύτερη κατανόηση τους. Αφού αναπτυχθούν οι εξισώσεις θα γίνει 
εφαρμογή στη λύση φυσικών προβλημάτων όπου συμβαίνουν κατά την κίνηση του 
ρευστού. 
 
 
2.5.1 Εξίσωση συνέχειας - Αρχή διατήρησης της μάζας. 
 
 

Σε αυτό το σημείο θα επικεντρωθούμε στο πεδίο ροής όπως παρουσιάζεται 
από τις ροϊκές γραμμές της Εικ.(2.4). Ας θεωρήσουμε μια καθορισμένη ποσότητα 
ύλης που εμπεριέχεται από την συνεχή γραμμή, σε κάποιο χρόνο t. Σε κάποιο χρόνο 
αργότερα t + Δt, το όριο του συστήματος έχει μια νέα φυσική θέση όπως 
παρουσιάζεται από τη διακεκομμένη γραμμή. 
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Εικόνα 2.4: .Σύστημα που κινείται μέσα από έναν όγκο ελέγχου 
 
 Λαμβάνοντας υπόψη τις περιοχές που σημειώνονται ως Α, Β και C έχουμε το 
σύστημα να συμπεριλαμβάνει την περιοχή Α στο χρόνο t και στον χρόνο t +Δt να 
συμπεριλαμβάνει τις περιοχές Β και A-C. Θεωρώντας ότι το m αναπαριστά τη μάζα 
που περιέχεται στις διαφορετικές περιοχές και σε διαφορετικούς χρόνους με τους 
κατάλληλους δείκτες, 
 
 ( )     –     ( ) ( ) ( ) A A c Bm t m t t m t t m t t= + D + D + + D    Εξ.(2.16) 
 
αναδιατάσσοντας τους όρους και διαιρώντας με το Δt, 
 

 
( ) ( )( )     )  ( c BA A m t t m t tm t t m t

t t
-+ D + D+ -D

D D
=   Εξ.(2.17) 

 
παίρνοντας το όριο καθώς Δt → 0, το αριστερό τμήμα της εξίσωσης γίνεται 
 

 
( )

.0

( ) ( )      ( )lim ( ) .A A c B
ct c v

m t t m t m t t m t t
t t

m v dV
t t

r
®D

- - ¶ ¶
= = =

¶ ¶
+D +D +D

D D ò  Εξ.(2.18) 

 
όπου ρ είναι η πυκνότητα, V δηλώνει τον όγκο και C.V. υποδηλώνει τον καθορισμένο 
όγκο ελέγχου στο χώρο και ορίζεται από την επιφάνεια ελέγχου (C.S.), το δεξιό 
τμήμα της εξίσωσης είναι 
 

 0

  ( ) (lim in out
c B

t

m t t m t t
t

m m
tD ®

+ D +ì ü- = -
D

í ý
î þ

D
D

& &
      Εξ.(2.19) 

 
που γίνεται: 
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 . .
cosin out A C V

m m V adA V dAr r- = - = -ò ò& &      Εξ.(2.20) 

 
Όπου ṁin και ṁout αναπαριστούν το ρυθμό ροής της μάζας μέσα και έξω από 

τον όγκο ελέγχου και V είναι το διάνυσμα ταχύτητας. Το V είναι μέτρο του 
διανύσματος της ταχύτητας και α είναι η γωνία μεταξύ του διανύσματος αυτού και της 
κάθετου στην επιφάνεια με διεύθυνση προς τα έξω. Τότε η εξίσωση συνέχειας του 
όγκου ελέγχου γίνεται: 
 

 
. . . .C V C V

V dA dV
t

r r
¶

=
¶ò ò        Εξ.(2.21) 

 
Η Εξ.(2.21) είναι η ολοκληρωτική μορφή της εξίσωσης συνέχειας και η φυσική 

της σημασία είναι ότι ο καθαρός ρυθμός της ροής μάζας έξω από την επιφάνεια 
ελέγχου είναι ίσος με τον ρυθμό της ελάττωσης της μάζας εντός του όγκου ελέγχου. 
Θα εξετάσουμε την Εξ.(2.21) λαμβάνοντας υπόψη πρώτα κάποιες γενικές 
απλοποιήσεις και ακολούθως κάποια συγκεκριμένα παραδείγματα. 
 Εφόσον ο όγκος ελέγχου είναι καθορισμένος, το δεξιό τμήμα της Εξ.(2.21) 
είναι μηδέν σε μόνιμη κατάσταση ( )/ 0tr¶ ¶ = δίνοντας: 
 

 
. .

0
c s

V d Ar =ò          Εξ.(2.22) 

 
Για ασυμπίεστη ροή έχουμε: 
 

 
. .

0
c s

V d A =ò          Εξ.(2.23) 

 
Δεδομένης της σταθερής ροής της Εικ.(2.5), όπου το ρευστό εισέρχεται στην τομή 1 
και εξέρχεται από τις τομές 2 και 3, έχουμε: 
 

 . .
0

c s
V d Ar =ò          Εξ.(2.24) 

 

2 3 1

0
A A A

V d A V d A V d Ar r r+ + =ò ò ò     Εξ.(2.25)
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Εικόνα 2.5: Συνέχεια ρευστού σε διακλαδισμένη ροή. 
 
Υποθέτοντας ότι η ταχύτητα είναι κάθετη σε όλες τις επιφάνειες από τις οποίες 
διέρχεται το ρευστό, 
 

 
2 3 1

2 2 3 3 1 1 0
A A A

V dA V dA V d Ar r r+ - =ò ò ò      Εξ.(2.26)
 

 
Αν οι πυκνότητες και οι ταχύτητες είναι ομοιόμορφες στις αντίστοιχες επιφάνειες, 
 
 2 2 2 3 3 3 1 1 1 0V A V A V Ar r r+ - =     Εξ.(2.27) 
 
Για ένα μόνο σωλήνα χωρίς δεύτερη έξοδο, η εξίσωση γίνεται, 
 

 2 2 2 1 1 1V A V Ar r=        Εξ.(2.28) 
 

Οι παραδοχές που έγιναν φτάνοντας στην Εξ.(3.4) είναι (α) μόνιμη κατάσταση, 
(β) ταχύτητες κάθετες στις επιφάνειες, (γ) ταχύτητα και πυκνότητα σταθερές στις 
αντίστοιχες επιφάνειες και (δ) μια έξοδο και μια είσοδο στον όγκο ελέγχου. 
 
 
2.5.2 Εξισώσεις ορμής - Δεύτερος νόμος της κίνησης του Νεύτωνα. 
 

Σε αυτό το σημείο θα αναπτύξουμε την εξίσωση της ορμής για τον όγκο 
ελέγχου. Αυτή η εξίσωση είναι μια από τις πιο σημαντικές μαθηματικές σχέσεις της 
κίνησης ρευστού. Μας δίνει τη δυνατότητα να αντιμετωπίσουμε προβλήματα που 
έχουν να κάνουν με δυνάμεις ρευστών σε στερεές επιφάνειες και σε άλλα ρευστά, 
όπως η δύναμη που ασκείται σε κυρτό τμήμα ενός αγωγού, η ώση ενός 
αεριωθούμενου κινητήρα (κινητήρας jet), η άντωση και η οπισθέλκουσα στο φτερό 
ενός αεροπλάνου και πολλές άλλες. 
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 Η καθαρή δύναμη F που ασκείται σε ένα σωματίδιο ή σε ένα σύστημα 
σωματιδίων σταθερής μάζας δίνεται από το δεύτερο νόμο του Νεύτωνα, 
 

 
d MF
d t

=          Εξ.(2.29)
 

 
Όπου Μ είναι η ολική γραμμική ορμή του συστήματος. Αν υποθέσουμε ότι η δύναμη 
είναι σταθερή για ένα χρονικό διάστημα Δt, μπορούμε να γράψουμε, 
 
 F t MD = D          Εξ.(2.30) 
 
Το δεύτερο μέρος της Εξ.(2.30) είναι, αναφορικά με την Εικ.(2.4), 
 
 ( ) ( ) ( ) ( )A C AM M t t t t t t M tBD = + D - M + D + M + D -    Εξ.(2.31) 
 
Αναδιατάσσοντας και διαιρώντας με Δt, 
 

 
( ) ( ) ( ) ( )A A CM t t M t t t t tM

t t t
B+ D - M + D - M + DD

= +
D D D

   Εξ.(2.32)
 

 
Παίρνοντας το όριο της Εξ.(2.32) για Δt → 0, ο πρώτος όρος από τη δεξιά πλευρά 
γίνεται: 
 

 ( ) ( ) ( )C . V . .0
lim A A

C Vt

M t t M t
V dV

t t t
r

D ®

+ D - ¶ ¶
= M =

D ¶ ¶ ò    Εξ.(2.33)
 

 
Και ο δεύτερος όρος γίνεται: 
 

( ) ( ) ( ) ( )
0 0

.S.

lim limC C
t t

C

out in
C

C

t tt tM t t M t t
t t t

mV mV

V V dAr

B B

D ® D ®

B

B

ì üé ùé ù DM + DDM + D+ D - + Dé ù ï ïê úê ú= -í ýê ú ê úê úD D Dë û ï ïê úê úë û ë ûî þ
é ù é ù= DM - DM = D - Dë û ë û

=

åå

å å å å

ò

& & & &



 Εξ.(2.34) 
 

Όπου ( )t t
B

DM + Då  είναι η ορμή που σχετίζεται με τη μάζα που έχει περάσει 

το όριο στην περιοχή Β σε χρόνο Δt. Το 
B

DMå &  εκφράζει τον ρυθμό με τον οποίο η 

ορμή περνά την επιφάνεια μέσα στην περιοχή Β σε χρόνο t. Επομένως η εξίσωση 
(2.34) γίνεται: 
 

 . . .S.CV C
F V dV V VdA

t
r r

¶
= +

¶ ò ò
      

Εξ.(2.35)
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Η συνολική δύναμη F αποτελείται από τη συνολική επιφάνεια Fs (πίεση και διατμητική 
τάση) και μια δύναμη μάζας Β, η οποία είναι μια δύναμη ανά μονάδα όγκου. Η 
εξίσωση της ορμής για έναν όγκο ελέγχου γίνεται: 
 

 . . . . .S.s C V C V C
F BdV V dV V V dA

t
r r

¶
+ = +

¶ò ò ò       Εξ.(2.36)
 

 
Πρέπει να τονιστεί ότι αυτή η εξίσωση ισχύει μόνο όταν πρόκειται για άξονες 

που κινούνται χωρίς επιτάχυνση, εφόσον η συνήθης μορφή του νόμου του Νεύτωνα 
ισχύει κάτω από αυτές τις συνθήκες. Για σταθερή ροή και αμελητέες δυνάμεις μάζας, 
η Εξ.(2.36) γίνεται: 
 

 .S.s C
F V V dAr= ò          Εξ.(2.37)

 
 

Επιπλέον, αν υποθέσουμε ότι η πυκνότητα και η ταχύτητα είναι ομοιόμορφες 
στις περιοχές που το ρευστό διασχίζει την επιφάνεια ελέγχου, για μια είσοδο 1 και μια 
έξοδο 2, έχουμε: 
 

( )
( )
( )

2 1

2 1

2 1

,

,

X X X

Y Y Y

Z Z Z

F m V V

F m V V

F m V V

= -

= -

= -

å
å
å

&

&

&

     Εξ.(2.38)

 
 
 
2.5.3  Εξισώσεις ενέργειας - Αρχή διατήρησης της ενέργειας 
 

Η μαθηματική έκφραση του πρώτου νόμου της θερμοδυναμικής είναι, 
 

 Q W E- = D          Εξ.(2.39) 
 
Όπου:  
 Q = θερμότητα που προσδίδεται στο σύστημα 
 W = έργο που παράγεται από το σύστημα 
 ΔΕ = μεταβολή της ενέργειας του συστήματος 
 
Όπως είδαμε στις προηγούμενες ενότητες, τονίζεται ιδιαίτερα ότι αυτός ο νόμος 
ισχύει σε ένα σύστημα. Για αυτό σκοπός μας είναι, όπως και προηγουμένως, να 
προσδιορίσουμε τις μαθηματικές εκφράσεις για έναν όγκο ελέγχου. 
Η θερμότητα και το έργο της Εξ.(2.39) εμπεριέχουν μια αλληλεπίδραση του 
συστήματος με άλλα συστήματα. Η ενέργεια παρόλα αυτά, είναι ενέργεια που 
συσχετίζεται με τη μάζα του συστήματος και συνήθως χωρίζεται σε τρία τμήματα, 
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E U m V m g z= + +       Εξ.(2.40)
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Όπου: U = η εσωτερική ενέργεια που συσχετίζεται με μοριακή και ατομική 
συμπεριφορά 
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m V  = η κινητική ενέργεια 

mgz = δυναμική ενέργεια που συσχετίζεται με τη θέση του συστήματος στο 
βαρυτικό πεδίο της Γης. 
 

 
 

Εικόνα 2.6: Όγκος ελέγχου για ισοζύγιο ενέργειας. 
 
Θα γράψουμε την εξίσωση (2.39) με βάση τη μονάδα μάζας, 
 

q w e- = D          Εξ.(2.41) 
 
Όπου: q = Q/m 

w=W/m 
e=E/m 
 
Θεωρώντας το σύστημα σε χρόνο t όπως φαίνεται στην Εικ.(2.6). Σε κάποιο 

χρόνο αργότερα t + Δt το σύστημα έχει μεταφερθεί σε κάποια άλλη θέση. Η εξίσωση 
της ενέργειας για το σύστημα σε αυτή τη μεταβολή είναι, 
 
 f iQ W E E- = -          Εξ.(2.41) 
 
Όπου Εf είναι η τελική ενέργεια του συστήματος και Εi η αρχική ενέργεια. Διαιρώντας 
με Δt, 
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f iE EQ W

t t t
-

- =
D D D         Εξ.(2.42)

 
 
Ας υπολογίσουμε το δεξιό μέρος αυτής της εξίσωσης: 
 

( ) ( ) ( ) ( )

( ) ( ) ( ) ( )

f i A C B A

A A B C

E E E t t E t t E t t E t
t t

E t t E t E t t E t t
t t

- + D - + D + + D -
=

D D
+ D - + D - + D

= +
D D

  Εξ.(2.43)

 
 
Ο πρώτος όρος στα δεξιά γίνεται, καθώς Δt → 0, 
 

( ) ( ) ( ) . . . .0
lim A A

C V C Vt

E t t E t
E edm e dV

t t t t
r

D ®

+ D - ¶ ¶ ¶
= = =

D ¶ ¶ ¶ò ò   Εξ.(2.44)
 

 
Ο τελευταίος όρος γίνεται: 
 

( ) ( ) ( ) ( )B t t C t tB C
me meE t t E t t

t t t
+D +D

D D+ D + + D
= =

D D D

å å
   Εξ.(2.45)

 
 
Όπου το άθροισμα αναφέρεται στη μάζα που διέρχεται από τη επιφάνεια, Δm είναι η 
μάζα και e είναι η αποθηκευμένη ενέργεια που σχετίζεται με τη μάζα Δm. Στο όριο, 
καθώς Δt→0, η τελευταία εξίσωση γίνεται: 
 

( ) ( )
. .0

lim B C
out in C St

E t t E t t
edm edm e V dA

t
r

D ®

+ D - + D
= - =

D ò ò ò& &    Εξ.(2.46)
 

 
Έτσι έχουμε: 
 

 . . .S.0
lim f i

C V Ct

E E
e dV e F dA

t t
r r

D ®

- ¶
= +

D ¶ ò ò      Εξ.(2.47)
 

 
Έργο μπορεί να παραχθεί στο όριο του συστήματος από κάθετες και 

εφαπτόμενες τάσεις. Αναφερόμαστε στο έργο που παράγεται στο όριο του 
συστήματος εξαιτίας των κάθετων τάσεων (υδροστατική πίεση) ως το έργο ροής. Για 
παράδειγμα αυτό το έργο που παράγεται στο στοιχείο (Δm)B , κατά την μετακίνηση 
του εκτός της περιοχής Α σε χρόνο Δt και ίσο με το pdAΔx. Παρόλα αυτά, το dAΔx 
είναι ο όγκος του στοιχείου της μάζας Δm και μπορεί να γραφεί ως (Δm)Β/ρ . Για αυτό 
το έργο ροής για την εκροή και την εισροή είναι: 
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( )( ) ( )( )

( )

0 0

. .

/ /
lim lim

/

Bt t Ct t

t t
έ ή έ ή

CS

p m p mdW dW
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rr
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é ùD Dæ ö æ ö ê ú= = -ç ÷ ç ÷ D Dè ø è ø ê úë û
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ò 
  Εξ.(2.48) 

Η εξίσωση ενέργειας γίνεται: 
 

 ( )
. . . .

/
C V C S

dQ dWs e dV e p V dA
dt dt t

r r r
¶

- = + +
¶ ò ò      Εξ.(2.49)

 
 
Όπου, 
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e u V gz= + +         Εξ.(2.50)
 

 
Και (dWs/dt) είναι ο ρυθμός για όλο το έργο εκτός του έργου ροής. Η Εξ.(3.50) 

δηλώνει ότι ο ρυθμός της θερμότητας που προστίθεται στο σύστημα μείον το έργο 
που παράγεται από το σύστημα (εκτός του έργου ροής) είναι ίσος με το ρυθμό 
μεταβολής της αποθηκευμένης ενέργειας στον όγκο ελέγχου συν τον καθαρό ρυθμό 
εκροής της αποθηκευμένης ενέργειας και του έργου ροής έξω από τον όγκο ελέγχου. 
Ας θεωρήσουμε μια μονοδιάστατη ροή σε μόνιμη κατάσταση για τη συσκευή που 
φαίνεται στην Εικ.(2.7). Το έργο της διάτμησης που παράγεται στη διατομή του 
περιστρεφόμενου άξονα καλείται αξονικό έργο. Το έργο της διάτμησης που 
παράγεται σε όλα τα τμήματα του ορίου είναι μηδέν, διότι η ταχύτητα είτε είναι μηδέν 
είτε κάθετη στη δύναμη της διάτμησης. Γι’ αυτό από την Εξ.(2.50) έχουμε: 
 

 
1 2

2

2A A

dQ dWs p Vu gz VdA
dt dt

r
r+

æ ö
- = + + +ç ÷

è ø
ò     Εξ.(2.51)

 
 
Εφόσον η ροή είναι μονοδιάστατη τα p,V, u και ρ είναι σταθερά επάνω στις 
επιφάνειες Α1 και Α2. Εάν επιπρόσθετα σε αυτές τις παραδοχές, παραλείψουμε τις 
μεταβολές κατά την z διεύθυνση στις περιοχές αυτές, έχουμε: 
 

 
2 2

2 2 1 1
2 2 2 2 2 1 1 1 1 1

2 12 2
p V p VdQ dWs u gz V A u gz VA

dt dt
r r

r r
æ ö æ ö

- = + + + - + + +ç ÷ ç ÷
è ø è ø

  Εξ.(2.52)
 

 
Από τη εξίσωση συνέχειας έχουμε για μονοδιάστατη ροή σε μόνιμη κατάσταση, 
 

 1 1 1 2 2 2
dmV A V A ή
dt

r r paroc= = =       Εξ.(2.53)
 

 
Η οποία με αντικατάσταση στην εξίσωση ενέργειας δίνει: 
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 ( ) ( )
2 2

2 1 2 1
2 1 2 1

2 1 2
p p V VdQ dWs dmu u g z z

dt dt dtr r

é ùæ ö -
- = - + - + + -ê úç ÷

è øë û
   Εξ.(2.54)

 
 
Γράφοντας την εξίσωση (2.54) έτσι ώστε κάθε όρος να αναφέρεται σε μονάδα μάζας 
του ρευστού που ρέει, 

 
 

Εικόνα 2.7: Μια ποιοτική απεικόνιση της διάταξης ροής ρευστού με θερμότητα και έργο. 
 

( ) ( )
2 2

2 1 2 1
2 1 2 1

2 1 2s
p p V Vq w u u g z z
r r

æ ö -
- = - + - + + -ç ÷

è ø
   Εξ.(2.55)

 
 
Το οποίο είναι συνήθως ισοζύγιο ενέργειας της θερμοδυναμικής για μονοδιάστατη 
ροή σε μόνιμη κατάσταση. 
Η εξίσωση αυτή μπορεί να γραφεί σε όρους της ειδικής ενθαλπίας h =p/ρ + u. 
 

 ( ) ( )
2 2

2 1
2 1 2 12s

V Vq w h h g z z-
- = - + + -     Εξ.(2.56)

 
 
Ανακατατάσσοντας την Εξ.(2.56) και θεωρώντας ασυμπίεστη ροή, 
 

 ( ) ( )
2 2

2 1 2 1
2 1 2 12s

p p V Vw g z z u u q
r
- -

- = + + - + - -    Εξ.(2.57)
 

 
Στις περισσότερες πραγματικές ροές, όλες οι ποσότητες της προηγούμενης εξίσωσης 
μπορεί να μετρηθούν κατευθείαν εκτός από την εσωτερική ενέργεια και τη μεταφορά 
θερμότητας. Για παράδειγμα, αυτό συμβαίνει σε ροές υγρών σε σωληνώσεις. Για 
αυτό, η συνήθης διαδικασία είναι να προσδιορίσουμε το 2 1LqH u u q= - -  έτσι ώστε: 
 

( )
2 2

2 1 2 1
2 12s L

p p V Vw g z z gH
r
- -

- = + + - +     Εξ.(2.58) 
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Όπου το HL  καλείται ως απώλεια μανομετρικού ύψους, ‘’head loss’’, και 
αντιπροσωπεύει τη μετατροπή της μηχανικής ενέργειας σε θερμική ενέργεια. 
Καθώς το ρευστό ρέει διαμέσου μιας αντλίας ή ενός σωλήνα, υποβάλλεται σε 
διατμητική παραμόρφωση, εφόσον το ρευστό που έρχεται σε επαφή με τη στερεή 
επιφάνεια δεν ολισθαίνει. Οι διατμητικές τάσεις εμφανίζονται στο ιξώδες ρευστό σαν 
αποτέλεσμα αυτών των παραμορφώσεων. Η αύξηση της θερμοκρασίας τείνει να 
αυξήσει και τα δύο μεγέθη u2 – u1 και η θερμότητα μεταφέρεται στο περιβάλλον. 
Για την ροή χωρίς τριβές ενός ασυμπίεστου ρευστού με μηδενικό μηχανικό έργο, η 
εξίσωση (3.22β) γίνεται: 
 

 ( )
2 2

2 1 2 1
2 1 0

2
p p V V g z z

r
- -

+ + - =      Εξ.(2.59)
 

 
Εφόσον το HL είναι μηδέν. Θα συγκρίνουμε την εξίσωση αυτή με την εξίσωση 

Bernoulli, η οποία θα εξαχθεί αργότερα από τη εξίσωση της ορμής. Στην 
πραγματικότητα, το μόνο που μπορούμε να αποδείξουμε συγκρίνοντας την Εξ.(2.59) 
με το πρώτο ολοκλήρωμα της εξίσωσης της κίνησης, για ένα ασυμπίεστο ρευστό, 
είναι ότι το (u2 – u1 - q) είναι ένας όρος απωλειών μανομετρικού ύψους. Η Εξ.(2.58) 
αποτελεί μια γενικευμένη εξίσωση Bernoulli που προκύπτει κατευθείαν από την 
εξίσωση της ορμής. Είναι πολλή βασικό να κατανοήσουμε ότι η Εξ.(2.58) μπορεί να 
εξαχθεί αυστηρά από την εξίσωση της ορμής, αλλά όχι και η Εξ.(2.59). Η Εξ.(2.59) 
είναι μια γενική εξίσωση για συμπιεστή ροή, αλλά εφόσον είπαμε ότι η ροή είναι 
ασυμπίεστη, το ρευστό ενιαίο και ‘’συμπαγές’’, και το (u2 – u1 - q) είναι ένας όρος 
απωλειών χωρίς τις τριβές, τότε έχουμε αποσύρει κάθε πραγματική θερμοδυναμική 
πληροφορία. 
 Έτσι, παραμένει μόνο ένα ισοζύγιο μηχανικής ενέργειας πλέον της εξίσωσης 
κίνησης. Για ασυμπίεστη ροή χωρίς τριβές, η Εξ.(2.58) HL = 0, είναι ο πρώτος νόμος. 
Δηλαδή, η εξίσωση q – Δu = 0 για μια μοναδιαία μάζα ρευστού που ρέει, αποτελεί τον 
πρώτο νόμο της θερμοδυναμικής και είναι ανεξάρτητος της Εξ.(2.57). 
 Ο πρώτος νόμος της θερμοδυναμικής και ένα ισοζύγιο μηχανικής ενέργειας 
περιλαμβάνονται στη γενική εξίσωση ενέργειας Πρέπει να έχουμε κατά νου ότι το 
ισοζύγιο μηχανικής ενέργειας (ο ρυθμός της αύξησης της κινητικής και της δυναμικής 
ενέργειας είναι ίσος με τον ρυθμό που οι εφαρμοζόμενες δυνάμεις παράγουν έργο) 
μπορεί να ληφθεί από την εξίσωση της ορμής και είναι ανεξάρτητο του 
θερμοδυναμικού ισοζυγίου, το οποίο είναι γνωστό ως ο πρώτος νόμος της 
θερμοδυναμικής. 
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3 ΑΝΑΛΥΣΗ ΤΗΣ ΥΠΟΛΟΓΙΣΤΙΚΗΣ ΡΕΥΣΤΟΔΥΝΑΜΙΚΗΣ 

ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ΚΩΔΙΚΑ FLUENT 
 
 
 
3.1 Εισαγωγή στο λογισμικό Fluent  
 
 Το FLUENT είναι ένα υπολογιστικό πρόγραμμα με το οποίο μπορούμε να 
λύσουμε εύκολα, γρήγορα και κυρίως οικονομικά πολλά προβλήματα της 
ρευστοδυναμικής. Με την χρήση του FLUENT έχουμε την δυνατότητα να 
μοντελοποιούμε ροές, φαινόμενα μεταφοράς θερμότητας ακόμη και χημικές 
αντιδράσεις. Η κύρια δουλεία του προγράμματος αυτού είναι να εμφανίζει τα 
πρακτικά σχεδιαστικά του προβλήματα στο υπολογιστή, να τα ανάλυση και να τους 
δώσει μια λύση. Αυτό που μας αφορά στην παρούσα πτυχιακή είναι οι τεχνικές 
μοντελοποίησης του FLUENT για την προσομοίωση πολυάριθμων τύπων ροικών 
προβλημάτων. Κάποια από τα φυσικά φαινόμενα που μπορεί να μοντελοποιήσει το 
FLUENT είναι τα εξής: 
 

§ 2D/3D γεωμετρίες σε κυλινδρικό ή καρτεσιανό ή ακόμη και σε άλλο 
σύστημα 

§ Αντίδρασή ή και ανάμιξη χημικών ουσιών 
§ Ροή ρευστού μέσα από πορώδη υλικά 
§ Στρωτή ή τυρβώδη ροή ,ασυμπίεστη ή συμπιεστή ροή, σταθερή ή 

μεταβαλλόμενη ροή 
§ Μεταφορά θερμότητας με ακτινοβολία, αγωγή ή συναγωγή 

Η οργάνωση και η σωστή πορεία που θα ακολουθήσουμε για την διαδικασία 
της μοντελοποίησης μέχρι την λύση του προβλήματος είναι σημαντική για την 
διεξαγωγή σωστών αποτελεσμάτων. 
Έτσι χωρίζουμε την μοντελοποίηση στα εξής βήματα: 
 

i. Καθορίζουμε των στόχων της μοντελοποίησης, δηλαδή προσδιορίζουμε 
τον βαθμό ακρίβειας που απαιτείται, τα φυσικά μοντέλα που θα 
χρησιμοποιήσουμε, το αποτέλεσμα που επιθυμούμε κτλ. 

ii. Επιλογή του υπολογιστικού μοντέλου προσδιορίζοντας το πεδίο που μας 
αφορά, αποφασίζουμε αν θα είναι 2D ή 3D και επιλέγουμε τις απαραίτητες 
οριακές συνθήκες. 

iii. Κατασκευή της γεωμετρίας, χωρίς τα χαρακτηριστικά που δεν χρειάζονται 
για την λύση του προβλήματος για να απλοποιηθεί η διαδικασία. 

iv. Δημιουργία και κατασκευή του πλέγματος χρησιμοποιώντας όγκους 
ελέγχου για την ακρίβεια που απαιτείται σε κάθε σημείο του προβλήματος. 

v. Επιλογή του φυσικού μοντέλου ανάλογα με το είδος της ροής που έχουμε. 
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vi. Καθορισμός της διαδικασίας της λύσης, για την σωστή λύση πρέπει να 
επιτύχουμε σύγκλιση της μεθόδου. Για να γίνει αυτό πρέπει να μειωθούν 
κάποια μεγέθη όπως ο υπολογιστικός χρόνος και η υπολογιστική ισχύος. 

vii. Ανάλυση των αποτελεσμάτων, αν το αποτέλεσμα δεν είναι το επιθυμητό 
τότε αρχίζουμε τις διορθώσεις του μοντέλου από το βήμα «δημιουργία και 
κατασκευή του πλέγματος» και συνεχίζουμε με τα επόμενα βήματα. 

 
 
 
3.2 Συνοριακές συνθήκες 
 

Ο καθορισμός των συνοριακών συνθηκών ή πιο απλά ο καθορισμός της  
θέσης των ορίων όπως η είσοδος, η έξοδος, τα τοιχώματα κτλ δίνει στο πρόβλημα 
μας μία και μοναδική λύση. Η οριακές συνθήκες μας δίνουν πληροφορίες για όλες τις 
μεταβλητές που μας αφορούν εντός των ορίων του υπολογιστικού πλέγματος. 

Τα είδη των συνοριακών συνθηκών που μας παρέχει το Fluent μπορούμε να 
τα χρησιμοποιήσουμε ανάλογα με το πρόβλημα που έχουμε προς λύση και τις ροικές 
συνθήκες που μας ενδιαφέρουν. Οι οριακές συνθήκες που μας παρέχει το Fluent 
περιλαμβάνει τα εξής: 
 

· Εισαγωγή σημείων εισόδου και εξόδου της ροής 
· Εισαγωγή ορίων τοιχωμάτων 
· Επιλογή συμμετρικών ορίων 
· Επιλογή κυκλικών ορίων 
· Επιλογή περιοδικών ορίων 
· Προσδιορισμός αξονικών συνοριακών συνθηκών 
· Σημεία εισόδου και εξόδου ταχύτητας και πίεσης 

 
 
3.2.1 Συνοριακές συνθήκες εισόδου ταχύτητας 
 

Όρια εισόδου ταχύτητας ορίζονται ως τα μεγέθη των ταχυτήτων για όλες τις 
συνιστώσες της ταχύτητας. Σαν δεδομένα πρέπει να πάρουμε τις κατάλληλες 
βαθμωτές ποσότητες ανάλογες του προβλήματος που έχουμε και της λύσης που 
επιθυμούμε ως αποτέλεσμα. Τα δεδομένα που απαιτούνται για την σωστή διαδικασία 
της λύσης είναι τα ακόλουθα: 
 

· Τις καρτεσιανές συνιστώσες της ταχύτητας 
· Τα μαζικά κλάσματα των χημικών ειδών 
· Την κλίμακα μήκους για την έντασης της τύρβης 
· Τη ροή της μάζας 
· Τη στατική πίεση 
· Τη θερμοκρασία 
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3.2.2 Συνοριακές συνθήκες εισόδου πίεσης 
 

Οι συνοριακές συνθήκες εισόδου πίεσης είναι αναγκαίες σε ένα ροικό 
πρόβλημα για τον καθορισμό της πίεσης του ρευστού στα σημεία της εσόδου ή της 
εξόδου ή και των δύο. Επίσης αυτές οι συνθήκες καθορίζουν και άλλες βαθμωτές 
ιδιότητες της ροής. Για την εφαρμογή αυτών των συνθηκών πρέπει να έχουμε ως 
δεδομένο την αλλαγή πίεσης από την είσοδο στην έξοδο, χωρίς να είναι απαραίτητο 
να γνωρίζουμε τον ρυθμό της ροής ή ακόμα και την ταχύτητα της. Επίσης μπορούν 
να χρησιμοποιηθούν σε μία ροή στην οποία υπάρχουν πάνω από μία έξοδο ή ακόμα 
και σε προβλήματα με εξωτερικές ροές με τον καθορισμό κάποιου «ελεύθερου» 
ορίου. 

Όταν πραγματοποιείται η είσοδος της πίεσης μέσω του ανάλογου κελιού 
εισόδου πίεσης τότε την χαρακτηρίζουμε σαν μία ολική πίεση, ενώ όταν βγαίνει από 
αυτόν τον τομέα τη αντιμετωπίζουμε ως στατική πίεση. Στην συνέχεια αναγράφεται τι 
περιλαμβάνει το λογισμικό του fluent  στα κελιά εισόδου πίεσης: 

 
· Ολική πίεση 
· Στατική πίεση 
· Θερμοκρασία 
· Ρυθμό σκέδασης και τυρβώδη κινητική ενέργεια 
· Κλάσματα μάζας των χημικών στοιχείων 
· Γωνία ροής 

Οι συνθήκες ορίου της πίεσης χρησιμοποιούνται είτε μόνες τους είτε σε 
συνδυασμό με της συνθήκες ορίου της ταχύτητας δια μέσου των συνθηκών εισόδου 
ταχύτητας. Όλοι οι συνδυασμοί εισόδου πίεσης και εισόδου ταχύτητας είναι καλά- 
προσδιορισμένοι, φυσικά χρειάζεται προσοχή έτσι ώστε να μην χρησιμοποιείται σε 
υπερηχητική έξοδο μια συνθήκη εισόδου πίεσης. Οι συνθήκες εισόδου πίεσης δεν 
μπορούν να παρουσιάζονται και ως συνθήκες εξόδου πίεσης στο ίδιο πρόβλημα 
εκτός από την περίπτωση που η ροή μας είναι στην κατηγορία των διαχυτικών ροών. 
 
 
3.2.3 Συνοριακές συνθήκες εξόδου ταχύτητας και πίεσης 
 
 Αυτές οι συνθήκες είναι αποκλειστικά για τη μοντελοποίηση εξόδου της ροής. 
Αυτό που πρέπει να λάβουμε υπόψη είναι ότι δεν έχουμε ως δεδομένα την ταχύτητα 
και την πίεση της ροής για την λύση του προβλήματος. Τις οριακές συνθήκες στα 
κελία εξόδου δεν τις εισάγουμε εμείς αλλά μας τις παρέχει το λογισμικό του fluent. Οι 
εσωτερικές οριακές συνθήκες που περιέχει και εφαρμόζει το λογισμικό του fluent στα 
κελία εξόδου είναι οι εξής: 
 

I. Μηδενικός ρυθμός διάχυσης: 

Οι συνοριακές συνθήκες εξόδου με μηδενικό ρυθμό διάχυσης για όλες της 
μεταβλητές εκτός της πίεσης εφαρμόζεται στα κελιά εξόδου, έτσι συνεπάγεται ότι οι 
συνθήκες του επιπέδου εξόδου παρατείνονται εντός των ορίων του τομέα και δεν 
αλληλεπιδρούν με την ανάντη ροή. Με αυτή την διαδικασία ενημερώνει την πίεση και 
την ταχύτητα εξόδου στην ροή αφού προηγούμενος αναδείξουμε ότι η ροή του 
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προβλήματος είναι πλήρως ανεπτυγμένη από την στιγμή που δεν υφίσταται κάποια 
αλλαγή στην επιφάνεια της εξόδου. 

Οι συνθήκες αυτές εφαρμόζονται σε πλήρες ανεπτυγμένες ροές στα όρια της 
εξόδου. Οι πλήρως ανεπτυγμένες ροές είναι η ροές όπου το προφίλ των ταχυτήτων 
της ροής παραμένει σταθερό σε όλο το μήκος της. Η θεώρηση μηδενικού ρυθμού 
διάχυσης όταν δεν επηρεάζει το αποτέλεσμα της λύσης γίνεται πιο εύκολη στα 
φυσικά όρια όπου η ροή που δεν είναι πλήρως ανεπτυγμένη με την χρήση των 
κελιών εξόδου. 
 

II. Συνολική διόρθωση της ισορροπίας της μάζας σε υποηχητικές 
ροές: 

Με αυτή την συνθήκη επιταχύνουμε τη σύγκλιση και σε καμία περίπτωση αυτό 
δεν λειτουργεί αρνητικά ως προς τη λύση του προβλήματος. Όταν η λύση συγκλίνει 
και σε κάθε σημείο του όγκου ελέγχου επικρατεί ισορροπία στη μάζα τότε λέμε ότι η 
συγκεκριμένη διόρθωση είναι ίση με το μηδέν. Στην περίπτωση που δεν συγκλίνει η 
λύση του προβλήματος η ταχύτητα στο εξωτερικό όριο μπορεί να ενημερώνεται σε 
κάθε επανάληψη με συνέπεια η ροή εξόδου να ισοσταθμίζεται με την ροή στην έξοδο. 
 
 
3.2.4 Συνοριακές συνθήκες τοιχωμάτων 
 
 Σε αυτές τις συνθήκες το fluent υπολογίζει τη διατμητική τάση που ασκείτε και 
ακόμη και την μεταφορά θερμότητας που υπάρχει ανάμεσα στο ρευστό και το 
τοίχωμα, το οποίο είναι βασισμένο στο τοπικό ροικό πεδίο και στα στοιχεία της ροής. 
Ακόμη τα τοιχώματα χρησιμοποιούνται ως θερμικές οριακές συνθήκες για άλλες 
συμπαγείς περιοχές, π.χ. : αγώγιμα κελία τοιχωμάτων. 
 Αναλόγως με τις ιδιότητες της ροής που έχει το ρευστό στα τοιχώματα το fluent 
προβλέπει τις διατμητικές τάσεις σε εκείνα τα σημεία. Όταν συναντάμε στρωτή ροή 
τότε ο υπολογισμός αυτός εξαρτάται από την κλίση της ταχύτητας στο τοίχωμα, ενώ 
όταν συναντάμε τυρβώδη ροή εφαρμόζεται ο λογιστικός νόμος στον τοίχο από το 
λογισμικό του fluent. 
 
 
3.2.5 Συμμετρικές συνοριακές συνθήκες 
 
 Στις συγκεκριμένες συνοριακές συνθήκες δεν είναι αναγκαίο να εισάγουμε 
δεδομένα για τα συμμετρικά όρια αφού αυτά τα δεδομένα μας τα παρέχει αυτόματα 
το λογισμικό πρόγραμμα του fluent. Φυσικά θα πρέπει να δώσουμε την ανάλογη 
βαρύτητα ώστε να προσδιοριστούν σωστά οι περιοχές συμμετρίας. Αυτές οι 
συνθήκες εφαρμόζονται όταν υπάρχει ομοιότητα, στην φυσική γεωμετρία που μας 
αφορά και στην προσδοκώμενη μορφή της ροικής και θερμικής λύσης, στο 
κατοπτρικό είδωλο. 
 Εφόσον υπάρχει συμμετρία το fluent εφαρμόζει μηδενική διακύμανση όλων 
των στοιχείων στα συμμετρικά όρια. Πιο κάτω θα δούμε περιληπτικά κάποιες από τις 
συμμετρικές συνοριακές συνθήκες και θα τις χωρίσουμε στις εξής κατηγορίες: 
 

· Μηδενική ταχύτητα σε συμμετρικό επίπεδο η οποία εφαρμόζεται κάθετα 
· Κάθετες μηδενικές κλίσεις όλων των μεταβλητών σε συμμετρικό επίπεδο 
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Στην πρώτη κατηγορία δημιουργείται ασύμμετρη ροή λόγω της άνωσης, ενώ 
στην δεύτερη με τον στροβιλισμό στη ροή αναπτύσσεται μια ροή σε επίπεδο που 
έπρεπε να είναι συμμετρικό. 

Ακόμη μια χρήσιμη πληροφορία για τις συμμετρικές συνοριακές συνθήκες είναι 
ότι είναι ταυτόσημες με αυτές του λείου τοιχώματος. Ιδιαίτερη προσοχή επιβάλλεται 
στην περίπτωση όπου η γεωμετρία είναι συμμετρική αντιθέτως με την ροή που 
μπορεί να μην είναι. 

Τέλος αν μια ροή εφαρμόζεται συμμετρικά κατά μια κατεύθυνση ή έναν άξονα, 
τότε αυτομάτως έχουμε δεδομένο ότι δεν υφίσταται ροή κατά το μήκος του ορίου. 
Αυτό αποδίδεται από την απαίτηση η κανονική ταχύτητα κατά μήκος του συμμετρικού 
ορίου να είναι ίση του μηδενός. 
 
 
3.2.6 Κυκλικές συνοριακές συνθήκες 
 
 Οι κυκλικές συνοριακές συνθήκες εφαρμόζονται όταν η φυσική γεωμετρία του 
αντικειμένου μας απασχολεί και η προσδοκώμενη μορφή της ροικής-θερμικής λύσης 
έχουν μια κυκλικά επαναλαμβανόμενη φύση. Και αυτές οι συνθήκες όπως και οι 
συμμετρικές συνοριακές συνθήκες δεν προσδιορίζονται στα κυκλικά όρια αλλά 
εισάγονται από το fluent. Φυσικά η τοποθεσία των κυκλικών ορίων θα πρέπει να γίνει 
με απόλυτη προσοχή και με ορθό τρόπο. 
 Η ροή στα κυκλικά όρια αντιμετωπίζεται από το fluent σαν να είναι το αντίθετο 
κυκλικό επίπεδο στα γειτονικά ενεργά κελία του πρώτου κυκλικού ορίου. Οπότε κατά 
την διάρκεια της διαδικασίας του υπολογισμού της ροής δια μέσω του κυκλικού ορίου 
στο προσαρμοσμένο ενεργώ κελί, το fluent καλεί τις συνθήκες ροής στο ενεργώ κελί 
σε συνεργασία με το προσαρμοσμένο στο αντίθετο κυκλικό επίπεδο. 
 Τα κυκλικά επίπεδα προσδιορίζονται πάντα σε ζευγάρια και αυτό γίνεται με 
τους απαραίτητους περιορισμούς, οι οποίοι αναφέρονται πιο κάτω: 
 

· Στην περίπτωση που καθορίζεται η γεωμετρία ενός προβλήματος σε αυτά που 
έχουν περιστρεφόμενα κυκλικά όρια η γεωμετρική κεντρική γραμμή είναι 
αναγκαίο να προσδιοριστεί σαν ένας άξονας z αν επιθυμούμε να λύσουμε το 
πρόβλημα σε καρτεσιανό επίπεδο ή διαφορετικά σαν άξονας x αν πάρουμε 
κυκλικές συντεταγμένες ταχύτητας κατά την διαδικασία της λύσης. 

· Αντιστοιχεί μόνο ένα ζευγάρι κυκλικών επιπέδων για κάθε τέτοιου είδους 
πρόβλημα που έχουμε προς λύση. 

· Στον υπολογιστικό τομέα τα κυκλικά επίπεδα είναι απαιτείται να βρίσκονται 
στο πρώτο και το τελευταίο επίπεδο του. 

 
 
3.2.7 Περιοδικές συνοριακές συνθήκες 
 

Στην περίπτωση όπου το πεδίο ροής είναι περιοδικό σε μία ή πολλαπλές 
κατευθύνσεις υπάρχουν κάποιες πρακτικές εφαρμογές. Σε αυτές τις περιπτώσεις μας 
αρκεί να εξομοιώσουμε την ροή σε μία μόνο από τις επαναλαμβανόμενες περιοχές. 
Έτσι η ορθή αλληλεπίδραση με το εναπομείναν φυσικό πεδίο πραγματοποιείται μέσω 
των περιοδικών οριακών συνθηκών. Υπάρχουν δύο βασικοί τύποι περιοδικών 
συνθηκών οι οποίοι αναγράφονται στην συνέχεια. Η πρώτη συνθήκη περιλαμβάνει 



[34] 

μία περιοδική οριακή συνθήκη όπου μπορεί να μετατραπεί σε ένα άλλο όριο μέσα 
από μετατόπιση συντεταγμένων (coordinate translation). Η δεύτερη συνθήκη 
αναπαριστά περιοδικά όρια που δημιουργούνται από την περιστροφή 
συντεταγμένων, το φαινόμενο αυτό είναι γνωστό ως περιστροφική περιοδικότητα 
(rotational periodicity). 

Το fluent μας δίνει την δυνατότητα του υπολογισμού περιοδικών ή πλήρως 
ανεπτυγμένων ροών και μεταφοράς θερμότητας. Τις περιοδικές ροές τις βρίσκουμε 
σε πολλές εφαρμογές όπως σε ροές κατά μήκος των αγωγών ή και σε κανάλια 
εναλλάκτη θερμότητας. Στις περιοδικές ροές η γεωμετρία μεταβάλλεται με περιοδικό 
τρόπο στην διεύθυνση της ροής, καταλήγοντας έτσι σε μια πλήρως ανεπτυγμένη 
περιοδική ροή κατά την οποία η μορφή της ροής επαναλαμβάνεται σε διαδοχικούς 
κύκλους. Πολλές εφαρμογές της περιοδικής ροής περιλαμβάνουν πλήρως 
ανεπτυγμένη ροή σε αγωγούς και σωλήνες. Οι συγκεκριμένες συνθήκες 
επιταχύνονται μετά από ένα ικανοποιητικό μήκος εισόδου, που εξαρτάται από τη 
γεωμετρική διαμόρφωση και τον αριθμό Reynolds της ροής. 

Οι συνθήκες περιοδικής ροής χρησιμοποιείται όταν υπάρχει μία επανάληψη 
στο προφίλ της ταχύτητας περιοδικά σε ένα μήκος L, με το οποίο εμφανίζεται και μία 
περιοδικά σταθερή πτώση πίεσης κατά μήκος του περιοδικού μήκους. 

Αρχικά δημιουργούμε ένα πλέγμα με κυκλικό τύπο κελίων κατά μήκος των 
γραμμών του πλέγματος Ι= 1 και I= IMAX και στην συνέχεια υπολογίζεται ένα χωρικά 
περιοδικό ροικό πεδίο με δεδομένο ρυθμό ροής της μάζας. Τα κυκλικά αυτά επίπεδα 
πρέπει να εμφανίζουν μία συνέχεια στην απόσταση του πλέγματος, επίσης θα 
πρέπει να είναι παράλληλα το ένα με το άλλο και να έχουν το ίδιο μέγεθος. Μόλις 
τελειώσουμε με τον καθορισμό των κυκλικών κελίων ορίζουμε τα κυκλικά όρια του 
τύπου (translationally cyclic). Με την τελευταία επιλογή μπορεί να δοθεί η εντολή 
ώστε να γίνει η μοντελοποίηση της περιοδικής ροής. 
 
 
3.2.8 Αξονικές συνοριακές συνθήκες 
 
 Οι συγκεκριμένες συνοριακές συνθήκες χρησιμοποιούνται όταν πολλαπλές 
γραμμές του πλέγματος τυγχάνει να βρίσκονται σε ένα συγκεκριμένο σημείο, σε ένα 
τρισδιάστατο κυλινδρικό πολικό πλέγμα. Τα αξονικά κελία προσδιορίζονται από το 
fluent με ειδικές συνθήκες για να μην δημιουργούνται πολλαπλές φυσικές τιμές σε 
ένα σημείο λόγω του ότι αυτό διαιρείται από πολλά κελιά, μια πολλή καλή εφαρμογή 
αυτών είναι για πλέγματα Ο-τύπου με πάρα πολύ μικρή εσωτερική ακτίνα. Οι 
συνθήκες για τα αξονικά όρια δεν καθορίζονται από τον χρήστη αλλά εισάγονται όλα 
τα δεδομένα από το fluent μόλις επιλεγεί το κελί. 
 Για τον προσδιορισμό της κατάλληλης φυσικής τιμής για κάποια 
προκαθορισμένη μεταβλητή σε ένα σημείο του άξονα, το fluent υπολογίζει τη μέση 
τιμή στο μέσω των κελιών που είναι γύρω από το σημείο που εξετάζεται. Στην 
συνέχεια αυτή η μέση τιμή εφαρμόζεται σε κάθε ένα ξεχωριστά από τα συνοριακά 
κελία που πλαισιώνουν τον άξονα. 
 Για την εφαρμογή των αξονικών συνοριακών συνθηκών πρέπει να τηρούνται 
και οι εξής παράμετροι: 
 

· Σε κάθε πρόβλημα αντιστοιχεί μόνο ένα όριο άξονα. 
· Όταν χρησιμοποιείται κυλινδρικός μετασχηματισμός της ταχύτητας πρέπει η 

αξονική κατεύθυνση να είναι η κατεύθυνση Χ. Ενώ στην περίπτωση όπου 
χρησιμοποιείται η επιλογή για καρτεσιανή διατύπωση της ταχύτητας, 
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επιλέγονται κατεύθυνσης X, Y, ή Ζ ως αξονική κατεύθυνση, ακόμη μπορεί να 
διατυπωθεί ένας καμπύλος άξονας. 

· Η συνθήκη του ορίου άξονα δεν δύναται να εφαρμοστεί σε 2D πολικά 
πλέγματα. Στα συγκεκριμένα πλέγματα πρέπει να εφαρμοστούν συνθήκες 
συμμετρίας στο εσωτερικό όριο και να δοθεί επίσης μικρή εσωτερική ακτίνα. 

 
 
 
3.3 Διαδικασία επίλυσης στο fluent 
 

Εφόσον έχουν καθοριστεί οι σωστές συνοριακές συνθήκες προχωράμε στην 
επιλογή του λύτη (solver) όπου θα χρησιμοποιήσουμε για την επίλυση του 
προβλήματος. Πιο κάτω θα γίνει μια αναφορά για τα είδη επιλυτών που υπάρχουν 
στο fluent. Το fluent μας παρέχει 2 είδη επιλυτών: 
 

1. Με βάση την πυκνότητα (Density Based) 
2. Με βάση την πίεση (Pressure Based) 

Οι αλγόριθμοι επίλυσης για την πρώτη περίπτωση μπορούν εφαρμοστούν κυρίως 
σε συμπιεστές ροές υψηλών ταχυτήτων με αναφλέξεις και υπερηχητικές ροές. Ενώ οι 
αλγόριθμοι για την δεύτερη περίπτωση έχουν την δυνατότητα εφαρμογής σε ένα 
μεγάλο εύρος ροών, από ασυμπίεστες ροές χαμηλών ταχυτήτων μέχρι και 
συμπιεστές ροές υψηλών ταχυτήτων. Επίσης είναι ευέλικτοι και δεν απαιτούν μεγάλη 
μνήμη. Στους επιλυτές με βάση την πίεση υπάρχουν δύο είδη αλγορίθμων: 
 

· Διαχωριστικοί αλγόριθμοι (Segregated Solver) όπου συναντάμε μια διαδοχική 
επίλυση των εξισώσεων και το αποτέλεσμα της προηγούμενης εξίσωσης 
μεταβιβάζονται στην επόμενη. 

·  Συζευγμένοι αλγόριθμοι (Coupled Solver) όπου οι εξισώσεις λύνονται 
ταυτόχρονα. 

Στη παρούσα πτυχιακή εργασία θα χρησιμοποιηθεί αλγόριθμος τύπου Pressure 
Based – Segregated Solver, αυτό που μας οδηγεί σε αυτή την επιλογή είναι καθαρά 
για λόγους οικονομίας στη μνήμη του υπολογιστή. Ο αλγόριθμος αυτός δεν απαιτεί 
μεγάλο χώρο μνήμης στον υπολογιστή διότι στις διακριτοποιημένες εξισώσεις 
απαιτείται η αποθήκευση μόνο μια φορά. Για τον λόγο αυτό η σύγκλιση είναι πιο 
αργή από τους άλλους αλγόριθμους που λύνουν τις εξισώσεις παράλληλα. 

Τα βήματα που ακολουθεί ένας αλγόριθμος επιλυτή Pressure Based – 
segregated Solver είναι τα εξής: 
 

1. Γίνεται ενημέρωση για τις ιδιότητες του ρευστού με βάση την υπάρχουσα λύση 
όπως ιξώδες, πυκνότητα κλπ. 

2. Επιλύονται οι εξισώσεις Navier-Stokes διαδοχικά παίρνοντας τις πρόσφατα 
ενημερωμένες τιμές πίεσης και ροής μάζας στις επιφάνειες. 

3. Επιλύονται οι εξισώσεις συνέχειας και συγκεκριμένα η διόρθωση της πίεσης 
χρησιμοποιώντας τις πρόσφατα ενημερωμένες τιμές στο πεδίο ταχυτήτων και 
της ροής μάζας ανά επιφάνεια. 
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4. Γίνεται επανενημέρωση της ροής μάζας ανά επιφάνεια, της πίεσης και του 
πεδίου ταχυτήτων ανάλογα με την διορθωμένη πίεση από το προηγούμενο 
βήμα. 

5. Επιλύονται οι εξισώσεις ενέργειας και τύρβης παίρνοντας τις τρέχουσες τιμές 
των μεταβλητών που επιλύονται. 

6. Γίνεται έλεγχος για την επίτευξη σύγκλισης ή όχι. 
7. Ανάλογα με το αν έχει επιτευχθεί σύγκλιση επαναλαμβάνουμε την διαδικασία ή 

την τερματίζουμε. 

 
 
 
3.4 Μέθοδος διακριτοποίησης των περασμένων όγκων. 
 

Για να προσεγγίσουμε το σύστημα των μερικών διαφορικών εξισώσεων ενός 
μοντέλου είναι αναγκαίο να κάνουμε πρώτα την σωστή επιλογή της μεθόδου 
διακριτοποίησης που θα χρησιμοποιήσουμε. Οι κύριες μέθοδοι της 
διακριτοποίησης χωρίζονται σε τρείς κατηγορίες και είναι οι εξής: 

 
· Η μέθοδος διακριτοποίησης των πεπερασμένων στοιχείων, 
· Η μέθοδος διακριτοποίησης των πεπερασμένων διαφορών, 
· Η μέθοδος διακριτοποίησης των πεπερασμένων όγκων. 

Στην συνέχεια θα γίνει μια γενική περιγραφή στις μεθόδους διακριτοποίησης 
των πεπερασμένων στοιχείων και των πεπερασμένων διαφορών, και ακολούθως θα 
πραγματοποιηθεί μια αναλυτική περιγραφή για την χρήση της μεθόδου 
διακριτοποίησης των πεπερασμένων όγκων. 
 
 
3.4.1 Γενική περιγραφή της μεθόδου. 
 
 Η μέθοδος διακριτοποίησης των πεπερασμένων όγκων είναι μια από της 
καλύτερες μεθόδους διακριτοποίησης στον τομέα της υπολογιστικής 
ρευστοδυναμικής για την επίλυση προβλημάτων. Αυτό που την κάνει να διαφέρει 
από τις υπόλοιπες μεθόδους είναι η δυνατότητα για την εφαρμογή της σε κάθε είδος 
πλέγματος, ακόμα και σε περίπλοκες γεωμετρίες. Η μέθοδος αυτή είναι απλή και 
συντηρητική, αφού τα επιφανειακά ολοκληρώματα μιας διεπιφάνειας είναι ίδια στις 
δύο πλευρές. Επίσης έχουν φυσική σημασία όλες οι μεταβλητές που υπολογίζονται 
και αυτό βοηθάει στην ευρεία χρήση της μεθόδου. Φυσικά υπάρχουν και 
μειονεκτήματα, όπως η δυσκολία που αφορά την ανάπτυξη σχημάτων μεγαλύτερης 
ακρίβειας από την δεύτερη για 3D πλέγματα μη-δομημένα. Η μέθοδος 
διακριτοποίησης των πεπερασμένων όγκων είναι μία αρκετά διαδεδομένη μέθοδος 
χωρικής διακριτοποίησης, όπου η δουλεία της είναι να μετατρέψει ένα δύσβατο 
σύστημα διαφορικών εξισώσεων σε ένα απλό σύστημα γραμμικών αλγεβρικών 
εξισώσεων. 
 Αρχικά, σύμφωνα με την μέθοδο αυτή ο χώρος ροής του ρευστού χωρίζεται σε 
ένα σύνολο όγκων, όπου ονομάζονται όγκοι ελέγχου ή όγκοι αναφοράς ή αλλιώς 
κυψέλες ελέγχου. Η διακριτοποίηση των διαφορικών εξισώσεων που αναφέρονται 
στην ροή του ρευστού, δημιουργούνται ολοκληρώνοντας τις εξισώσεις σε όγκους 
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αναφοράς. Τα διακριτικά σημεία του πεδίου εμπεριέχονται στους όγκους αναφοράς, 
όπου από εκεί θα βρεθούν οι μεταβλητές επίλυσης και είναι γνωστά ως υπολογιστικοί 
κόμβοι. Δηλαδή το κέντρο κάθε όγκου αναφοράς ξεχωριστά είναι και ένα διακριτό 
σημείο του πεδίου, όπου θα βρεθούν οι τιμές των μεταβλητών του προβλήματος, 
όπως για παράδειγμα η ταχύτητα, η πίεση, η θερμοκρασία κ.α. Η μέθοδος 
αναπαράστασης των υπολογιστικών κόμβων γίνεται με δύο τρόπους, είτε με 
κεντροκομβική μέθοδο είτε με κεντροκυψελική μέθοδο. Στην  κεντροκομβική μέθοδο 
κάθε υπολογιστικός κόμβος, όπου αποθηκεύονται τα ζητούμενα μεγέθη, βρίσκεται 
στο σημείο όπου τέμνονται οι γραμμές του πλέγματος και τα όρια των όγκων ελέγχου 
βρίσκονται ανάμεσα (στην μέση) των υπολογιστικών κόμβων. Σε αυτή την 
περίπτωση ο υπολογισμός των μεταβλητών στα κέντρα των όγκων ελέγχου είναι 
εξίσου ίσος με τον υπολογισμό τους σε όλους τους κόμβους του πλέγματος, αυτό 
συμβαίνει επειδή το κέντρο του όγκου ελέγχου συμπίπτει με έναν κόμβο του 
πλέγματος. Στην περίπτωση της κεντροκυψελική μεθόδου συμβαίνει το αντίθετο 
αφού οι γραμμές του πλέγματος διαμορφώνουν τα όρια των όγκων ελέγχου και οι 
υπολογιστικοί κόμβοι εντοπίζονται στα κέντρα τους. Πιο κάτω φαίνονται οι δύο 
μέθοδοι αναπαράστασης των όγκων ελέγχου για καρτεσιανό δισδιάστατο δομημένο 
πλέγμα: 
 

 
 

Εικόνα 3.1: Κεντροκομβική (αριστερά) και κεντροκυψελική (δεξιά) μέθοδος διακριτοποίησης. 
 

 
 
3.4.2 Διακριτοποίηση πεπερασμένων στοιχείων. 
 
 Η ανάπτυξη αυτής της μεθόδου ήταν αρχικά ένα εργαλείο επίλυσης για τα 
προβλήματα στον τομέα της αντοχής υλικών. Στην μέθοδο διακριτοποίησης των 
πεπερασμένων στοιχείων ο χώρος διαιρείται σε έναν αριθμό στοιχείων, τα οποία 
συνήθως δεν έχουν κάποια συγκεκριμένη δομή. Παρόλα αυτά η συγκεκριμένη 
μέθοδος επιδεικνύει έως σήμερα αρκετά καλά αποτελέσματα και μπορεί να 
εφαρμοστεί ακόμη και σε ιδιαίτερα περίπλοκες γεωμετρίες. Σαν πρώτο βήμα οι 
μερικές διαφορικές εξισώσεις πολλαπλασιάζονται σε κάθε στοιχείο με έναν 
συντελεστή, πριν συμπεριληφθούν στο σύστημα των εξισώσεων. Σαν δεύτερο και 
τελευταίο βήμα η λύση προσεγγίζεται με μία καινούργια συνάρτηση για κάθε στοιχείο 
έτσι ώστε να διαιρείται η συνάφεια της λύσης στα όρια των στοιχείων. Φυσικά είναι 
ακόμη το κύριο εργαλείο επίλυσης για τα δομικά προβλήματα, και ταυτοχρόνως 
γίνεται επιτυχώς η εφαρμογή της μεθόδου αυτής στα προβλήματα της υπολογιστικής 
ρευστοδυναμικής. 
 Η μέθοδος διακριτοποίησης των πεπερασμένων διαφορών εφαρμόζεται 
πολλή εύκολα σε απλές γεωμετρίες και είναι η παλαιότερη μέθοδος διακριτοποίησης 
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από τις τρεις μεθόδους που προαναφέραμε. Στην μέθοδο αυτή οι μερικές διαφορικές 
εξισώσεις σε ένα σημείο του πλέγματος προσεγγίζονται από αλγεβρικές σχέσεις. Οι 
σχέσεις αυτές περιλαμβάνουν τις τιμές των ποσοτήτων των γειτονικών στον κόμβο 
όπου εξετάζουμε. Για κάθε του πλέγματος υπάρχει και μια αλγεβρική εξίσωση, όπου 
η τιμή των μεγεθών στους γειτονικούς κόμβους και στον κόμβο που εξετάζουμε δεν 
είναι γνωστές. Αυτή η μέθοδος έχει την δυνατότητα να εφαρμοστεί σε οποιοδήποτε 
είδος πλέγματος, παρόλα αυτά συνήθως εφαρμόζεται σε δομημένο πλέγμα διότι είναι 
πιο εύκολος ο υπολογισμός των απαραίτητων παραγωγών. Επίσης η συγκεκριμένη 
μέθοδο έχει μια σχετική άνεση στο να δίνει προσεγγίσεις υψηλής τάξης. Υπάρχουν 
δύο συνήθεις μέθοδοι οι οποίες χρησιμοποιούνται για την δημιουργία των 
αλγεβρικών εξισώσεων, η μια είναι η πολυγαμική προσέγγιση και η άλλη η ανάπτυξη 
σε σειρές Taylor. Τέλος το συμπέρασμα που βγαίνει από την μέθοδο 
διακριτοποίησης των πεπερασμένων διαφορών είναι ότι είναι απλές στη διαχείριση, 
αλλά περιορίζεται στην εφαρμογή της αφού χρησιμοποιείται μόνο σε δομημένα 
πλέγματα. 
 
 
 
3.5 Μοντελοποίηση των όγκων ελέγχου. 
 
 Σε αυτήν την παράγραφο θα γίνει μια αναφορά στην μοντελοποίηση των 
όγκων ελέγχου. Αρχικά πρέπει να κάνουμε γνωστό ότι δεν μας περιορίζει κάτι ως 
προς τη γεωμετρία του όγκου ελέγχου. Κατά την μοντελοποίηση μπορούν να 
χρησιμοποιηθούν πολυεδρικές 3D γεωμετρίες. Οι όγκοι ελέγχου μπορούν να έχουν 
οποιαδήποτε γεωμετρία και αυθαίρετο αριθμό γειτονικών όγκων. Παρόλα αυτά η 
μέθοδος πεπερασμένων όγκων μπορεί να επεξεργαστεί με σχετική ευκολία μη-
δομημένα πλέγματα και να διαχειριστεί περίπλοκες γεωμετρίες. 
 Στην συνέχεια είναι απαραίτητη η δημιουργία μιας κοινής έκφρασης για τις 
εξισώσεις της συνέχειας, της διατήρησης της ορμής και της ενέργειας, πρώτου 
αναλύσουμε περαιτέρω την μέθοδο διακριτοποίησης των πεπερασμένων όγκων. Η 
νέα εξίσωση που δημιουργείται θα περιγράφει γενικά τις εξισώσεις όπου συντελούν 
το σύστημα των μερικών διαφορικών εξισώσεων. Την εξίσωση αυτή θα την 
χρησιμοποιήσουμε κατόπιν για την εφαρμογή της μεθόδου διακριτοποίησης των 
πεπερασμένων όγκων. Η εξίσωση που εκφράζει και τις τρεις μερικές διαφορικές 
εξισώσεις είναι η εξής: 
 

 

( ) ( ) ( )

( )

u v w
S

t x y z

div u S
t

J r J r J rJr
J J J J

Jr
r

J

F

F

F F FF
+ + + = Þ

F
+ F =

uuuv     Εξ.(3.1) 

 
Η πιο πάνω εξίσωση αποδεικνύει ότι οι μερικές διαφορικές εξισώσεις 

συνέχειας, ενέργειας και ορμής μιας ροής μπορούν να διατυπωθούν στην μορφή 
αυτή. Αυτή η εξίσωση αποτελεί την απαρχή των υπολογιστικών διαδικασιών για την 
μέθοδο πεπερασμένων διαφορών και για την μέθοδο των πεπερασμένων όγκων, με 
την οποία θα ασχοληθούμε στην συνέχεια. 

Η εξ.(3.1) είναι βασισμένη στο θεώρημα του Gauss, το θεώρημα αυτό μας 
δίνει την μαθηματική σχέση μεταξύ ενός ολοκληρώματος κατά μήκος μια επιφάνεια S 
που ορίζει τον όγκο V, και ενός ολοκληρώματος σε έναν όγκο V. Οπότε η εξίσωση 
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αυτή έχει την δυνατότητα να ολοκληρωθεί στον εκάστοτε όγκο ελέγχου του υπό 
εξέταση χωρικού πεδίου ροής. Η Εικ.(3.1) απεικονίζει τη σχηματική αναπαράσταση 
του θεωρήματος του Gauss. 
 

 
 

Εικόνα 3.2: Σχηματική αναπαράσταση του θεωρήματος Gauss. 
 

Αν υποθέσουμε ότι ως ῆ συμβολίζεται το κάθετο διάνυσμα στην επιφάνεια S, 
για το οποίο θέτουμε θετική φορά όταν αυτό εξέρχεται από τον όγκο V, τότε 
προκύπτει η εξής μαθηματική έκφραση (Εξ.(3.2)) του θεωρήματος Gauss: 
 

 ( )
V S

d iv q dV q ndS=òòò òò
v v v

     Εξ.(3.2) 

 
Ακολούθως θα αναφέρουμε με παραδείγματα στον τρόπο σχηματισμού του 

όγκου ελέγχου. Στην ακόλουθη Εικ.(3.3) φαίνεται ένα τμήμα του ενός όγκου ελέγχου 
3D μη δομημένου πλέγματος. Αυτό το τμήμα σχηματίζει επιμέρους τμήματα του 
όγκου ελέγχου, που συνεισφέρουν τρία από τα τετράεδρα, όπου ανήκει ο κόμβος Ν 
που φαίνεται στην εικόνα με κίτρινο χρώμα. Στην εικόνα θα δούμε επίσης τα μέσα 
των άκρων με μαύρο χρώμα, τα βούκεντρα των εδρών των τετράεδρων με κόκκινο 
χρώμα και τα βαρύκεντρα των κεντραεδρών με μπλε χρώμα. Όπως φαίνεται στο 
σχήμα οι κόμβοι A, B, C, D, E είναι γειτονικοί του κόμβου Ν και τα σημεία G1, G2, G3 
που φαίνονται στο σχήμα είναι τα βαρύκεντρα των τετράεδρων ABCN, AECN και 
ABDN αντίστοιχα. Ακόμα έχουμε το μέσω της ακμής που αναγράφεται με το γράμμα 
Μ και τα C1 και C2 όπου είναι τα βαρύκεντρα των εδρών ABN και ACN αντιστοίχως. 
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Εικόνα 3.3: Τμήμα κυψέλης ελέγχου για 3D μη δομημένο πλέγμα 
 
Η μαθηματική ολοκλήρωση της εξ.(3.2) διατυπώνεται ως εξής: 
 

 ( )
CV CV CV

dV div u dV S dV
t

Jr
r

J F

F
+ F =òòò òòò òòò

v
     Εξ.(3.3) 

 
 Έστω ότι ο παράγοντας ρΦ έχει σταθερό ρυθμό μεταβολής για τον όγκο 
ελέγχου που εξετάζεται, τότε ο πρώτος όρος της Εξ.(3.3) προσεγγίζεται ως εξής: 
 

 
( ) ( )

CV

dV VOL
t t

J r J r
J J

F F
@òòò        Εξ.(3.4) 

 
Όπου: VOL είναι ο όγκος της κυψέλης ελέγχου 
 
 Η υπόθεση που έγινε για τον παράγοντα ρΦ στην Εξ(3.4) είναι μια αρκετά 
καλή προσέγγιση στην περίπτωση που η τελευταία έχει μικρές διαστάσεις. 
 Ακολούθως εφαρμόζοντας το θεώρημα Gauss στον δεύτερο όρο της Εξ.(3.3), 
προκύπτει μια νέα διατύπωση ως εξής: 
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div u dV u nds unds u n dsr r r rF = F = F = Fåòòò òò òò òò
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   Εξ.(3.5) 

 
Όπου: S είναι η συνολική επιφάνεια του όγκου ελέγχου 

ῆ =συμβολίζει το κάθετο σε αυτή διάνυσμα 
 

Το πιο πάνω ολοκλήρωμα υπολογίζεται προσθέτοντας τα επιμέρους 
ολοκληρώματα τα οποία αντιστοιχούν σε μικρά τριγωνικά τμήματα που απαρτίζουν 
την επιφάνεια όγκου ελέγχου όπως τα επίπεδα επιμέρους τμήματα MC1G1 και 
MC2G1, που φαίνονται στην Εικ.(3.3). Οπότε ο υπολογισμός του δεύτερου όρου 
γίνεται με το άθροισμα των ολοκληρωμάτων που αντιστοιχούν σε όλα τα τριγωνικά 
τμήματα, τα οποία απαρτίζουν την επιφάνεια του όγκου ελέγχου. Το κάθετο 
μοναδιαίο διάνυσμα στο і επίπεδο τμήμα συμβολίζεται ῆі. Για τον υπολογισμό των 
επιμέρους ολοκληρωμάτων χρειάζεται να γνωρίζουμε τον όρο ρіΦіũіῆі σε όλα τα 
σημεία κάθε τριγώνου. Αυτό σε καμία περίπτωση δεν είναι εφικτό, αφού οι τιμές 
υπολογίζονται μόνο στο κέντρο κάθε όγκου ελέγχου. Παρόλα αυτά μπορούμε να την 
προσεγγίσουμε λαμβάνοντας την τομή του παραπάνω όρου στο μέσο κάθε ακμής 
που αρχίζει από τον κόμβο Ν. Για παράδειγμα στην ακμή της Εικ.(3.3) το τοπικό 
πρόβλημα Riemann επιλύεται μεταξύ των καταστάσεων που αντιστοιχούν στους δύο 
ακραίους κόμβους της ακμής δηλαδή των κόμβο Α και τον κόμβο Ν και ακολούθως 
υπολογίζεται η μέση τιμή κατά Roe του όρου στο μέσω της ακμής Μ. Στις τριγωνικές 
επιφάνειες MC1G1  και MC2G1 η τιμή αυτή θεωρείται σταθερή, άρα πάνω στις 
επιφάνειες αυτές υπολογίζονται και τα ολοκληρώματα, αφού πρώτα υπολογιστούν τα 
κάθετα διανύσματα ῆі : 
 

i i ii i M i
i

u n d s u n Sr rF = Fòò
v v v v

    Εξ.(3.6)
 

 
Όπου: Sі= εμβαδόν του τριγωνικού επιπέδου і, ενώ με την πάνω παύλα συμβολίζεται 
ο μέσος όρος. 
 Και τέλος ο υπολογισμός του τρίτου όρου της εξίσωσης προκύπτει από την 
σχέση: 
 

C V

S d V S V O LF F=òòò        Εξ.(3.7) 
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4 ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΚΑΙ ΠΡΟΣΕΓΓΙΣΗ ΠΡΟΒΛΗΜΑΤΟΣ 

ΡΟΗΣ ΑΙΜΑΤΟΣ ΕΝΤΟΣ ΑΡΤΗΡΙΑΣ ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ 
ΚΩΔΙΚΑ ANSYS ICEM 

 
 
 
4.1 Εισαγωγή. 
 
 
 Όπως αναφέρθηκε και παραπάνω, η εφαρμογή των μεθόδων της 
υπολογιστικής ρευστοδυναμικής πραγματοποιείται χρησιμοποιώντας ηλεκτρονικό 
υπολογιστή. Για την ανάλυση της ροής, πραγματοποιείται εφαρμογή του εμπορικού 
κώδικα Fluent και συγκεκριμένα η έκδοση 14.5 (Fluent, Inc. 2005). 
 Το πρόβλημα το οποίο θα αναλύσουμε παρακάτω, Εικ.(4.1) έχει σχέση με την 
ροή αίματος εντός αρτηρίας και παρέχεται σε εμάς από την βάση δεδομένων του 
ANSYS Inc. 

 

 
 

Εικόνα 4.1: Γεωμετρία αρτηρίας του προβλήματος ροής αίματος 
 
 Το πρόβλημα αυτό ροής που θα αναλύσουμε, επιλέχτηκε προκειμένου να γίνει 
εξοικείωση με προβλήματα ροής αίματος εντός αρτηριών. Επιπλέον θα γίνει 
κατανόηση των παρακάτω διαδικασιών: 
 

1. Εισαγωγή δεδομένων STL εντός του ANSYS ICEM CFD 
2. Ρύθμιση ολικών και μερικών παραμέτρων για λόγους πλεγματοποίησης 
3. Πλεγματοποίηση εφαρμόζοντας την μέθοδο Octree 



[43] 

4. Πλεγματοποίηση εφαρμόζοντας την μέθοδο Delaunay 
5. Έλεγχος πλεγματοποίησης χρησιμοποιώντας cut-planes 
6. Ομαλοποίηση της πλεγματοποίησης για αύξηση της ποιότητας. 

 
Παρακάτω θα γίνει αναλυτικότερη περιγραφή των όλων των προαναφερθέντων 

διαδικασιών.  
 
 
 
4.2 Προετοιμασία περιβάλλοντος εργασίας icem και εισαγωγή δεδομένων 

αρτηρίας. 
 

Αρχικά αντιγράφουμε το αρχείο της γεωμετρίας (Aorta.stl) που βρίσκεται στο 
αρχείο δεδομένων προβλημάτων ροής, στον επιθυμητό φάκελο εργασίας του 
προβλήματος. Στη συνέχεια ανοίγουμε το πρόγραμμα ANSYS ICEM CFD και 
εισάγουμε την γεωμετρία στο περιβάλλων εργασίας. 
 

File > Import Geometry > STL 
 

i. Επιλέγουμε το αρχείο STL στο παράθυρο που παρουσιάζεται κατά την 
εκκίνηση του προγράμματος και επιλέγουμε Open  

ii. Διατηρούμε την επιλογή Generate  για την και επιλέγουμε Done. 
iii. Επιλέγουμε Solid Full Display από το μενού Solidframe Display Options 

και στη συνέχεια παρατηρούμε την αρτηρία που εμφανίζεται στην Εικ.(4.1). 
 

 
 

Εικόνα 4.2: Γεωμετρία αρτηρίας 
 
 
 
4.3 Προσδιορισμός τμημάτων αρτηρίας. 
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Το αρχικό αρχείο γεωμετρίας αποτελείται από ένα μεμονωμένο τμήμα, την 
αρτηρία. Σε αυτό το κεφάλαιο θα χωρίσουμε την γεωμετρία σε επιμέρους τμήματα 
ώστε να γίνει πιο λεπτομερείς ανάλυση. 
 

1.  Χωρισμός γεωμετρίας: 
 

Geometry > Create/Modify Surface > Segment/Trim Surface 
 

 
 

Εικόνα 4.3: Επεξεργασία επιφάνειας. 
 

i. Επιλέγουμε By Angle από τη λίστα επιλογών Method. 
ii. Κάνουμε κλικ στην επιλογή Select Surface και επιλέγουμε την 

επιφάνεια της αρτηρίας. 
iii. Εισάγουμε 35 στο κελί Angle και επιλέγουμε Apply. (Εικ.(4.2)). 

 
2. Δημιουργία του τμήματος INLET: 

 
Αρχικά κάνουμε δεξί κλικ στην επιλογή Parts και στη συνέχεια Create Part 
 

i. Εισάγουμε INLET για ονομασία Part στο κελί Create Part DEZ. 
ii. Επιλέγουμε Select Entities. Στο σημείο αυτό μας εμφανίζεται μια 

βοηθητική εργαλειοθήκη ώστε να μπορέσουμε να επιλέξουμε την 
επιφάνεια INLET όπως φαίνεται και στην Εικ.(4.4) 

iii. Τέλος επιλέγουμε Apply. 
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Εικόνα 4.4: Προσδιορισμός επιφάνειας INLET. 
 

3. Δημιουργία του τμήματος OUTLET. 
 
Αρχικά κάνουμε δεξί κλικ στην επιλογή Parts και στη συνέχεια Create Part 
 

i. Εισάγουμε OUTLET για ονομασία Part στο κελί Create Part DEZ. 
ii. Επιλέγουμε Select Entities. Στο σημείο αυτό μας εμφανίζεται μια 

βοηθητική εργαλειοθήκη ώστε να μπορέσουμε να επιλέξουμε τις 
επιφάνειες OUTLETS όπως φαίνεται και στην Εικ.(4.5) 

iii. Τέλος επιλέγουμε Apply. 
 

 
 

Εικόνα 4.5: Προσδιορισμός επιφανειών OUTLET. 
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4. Στη συνέχεια θα μετονομάσουμε το τμήμα που αποτελείται από τα τοιχώματα 
της αρτηρίας σε AORTA_WALL. Κάνουμε δεξί κλικ στην επιλογή 
AORTA.MESH.PART1 που βρίσκεται στα Parts και επιλέγουμε Rename 
ώστε να μετονομάσουμε τα τοιχώματα σε AORTA_WALL. 

 
5. Στο σημείο αυτό θα επεξεργαστούμε τις καμπύλες των τοιχωμάτων κάνοντας 

κλικ (Εικ.(4.6)) στις παρακάτω επιλογές:  
 

Geometry > Create/Modify Curve > Extract Curves from Surfaces. 
 

 
 

Εικόνα 4.6: Επεξεργασία επιφανειών και καμπυλών της αρτηρίας. 
 

i. Επιλέγουμε Select surface και στη συνέχεια όλες τις επιφάνειες 
INLET και OUTLET. 

ii. Επιλέγουμε Create New από τη λίστα Extract Edges και έπειτα 
Apply. 

 
 
 
4.4 Δημιουργία υλικού σημείου 
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Geometry > Create Body 
 

 
 

Εικόνα 4.7: Κατασκευή σώματος. 
 

i. Εισάγουμε FLUID στο όνομα Part. 
ii. Επιλέγουμε Select Location και έπειτα δύο σημεία, όπου το κέντρο 

τους θα αντιπροσωπεύει το κέντρο κατά μήκος της αρτηρίας όπως 
φαίνεται στην Εικ.(4.8). 

 

 
 

Εικόνα 4.8: Εισαγωγή υλικού σημείου εντός του όγκου. 
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Τέλος επιλέγουμε Solid Full Display ώστε να μπορέσουμε να δούμε και πάλι 
την αρχική μορφή της αρτηρίας. 
 
 
 
4.5 Δημιουργία πλεγματοποίησης OCTREE. 
 

Αρχικά θα μετρήσουμε την μικρότερη διάμετρο στην γεωμετρία της αρτηρίας 
εστιάζοντας πάνω σε αυτή. Στη συνέχεια επιλέγουμε Measuring Distance και 
ορίζουμε δύο άκρα όπου η απόσταση τους θα αντιπροσωπεύει την διάμετρο που 
αναζητάμε (Εικ.(4.9)). 
 
 

 
 

Εικόνα 4.9: Διάμετρος αρτηρίας. 
 
 

1. Καθορισμός μεγέθους πλεγμάτων: 
 

Mesh > Global Mesh Setup > Global Mesh Size 
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Εικόνα 4.10: Καθορισμός μεγέθους κελιών πλεγματοποίησης. 
 
 

i. Όπως φαίνεται και στην Εικ.(4.10), εισάγουμε την τιμή 2 στο κελί Max 
Element. 

ii. Ενεργοποιούμε την επιλογή Curavature/Proximty Based Refinement 
και εισάγουμε 0.5 για Min size limit. 

iii. Ορίζουμε το Refinement στα 18 και επιλέγουμε Apply. 
 
 

2. Συγκεκριμενοποίηση τμημάτων για κατασκευή πρισμάτων. 
 

Mesh > Part Mesh Setup 
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Εικόνα 4.11: Ρυθμίσεις τμηματικής πλεγματοποίησης. 
 

i. Ενεργοποιούμε την επιλογή Prism για την AORTA__WALL. (Εικ.(4.11)) 
ii. Διατηρούμε τις υπόλοιπες ρυθμίσεις ως έχουν και τέλος επιλέγουμε Apply και 

Dismiss. 
 

3. Τροποποίηση των ρυθμίσεων Global prism settings. 
 

Mesh > Global Mesh Setup > Prism Mesh Parameters 
 

 
 

Εικόνα 4.12: Global Prism Settings 
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i. Εισάγουμε 0.25 για Ortho Weight. (Εικ.(4.12)) 
ii. Κατεβάζοντας προς τα κάτω την πλαϊνή μπάρα στη λίστα επιλογών, 

εισάγουμε στο κελί Number of volume smooth steps την τιμή 0. 
iii. Διατηρούμε όλες τις υπόλοιπες επιλογές ως έχουν και κάνουμε κλικ 

Apply. 
 

4. Υπολογισμός πλεγματοποίησης 
 

Mesh > Compute Mesh >Volume Mesh 
 

 
 

Εικόνα 4.13: Υπολογιστικές ρυθμίσεις πλεγματοποίησης. 
 

Στο σημείο αυτό ενεργοποιούμε την επιλογή Create prism layers και έπειτα 
συνεχίζουμε την διαδικασία υπολογισμού της πλεγματοποίησης όπως φαίνεται στην 
Εικ.(4.13). Το αποτέλεσμα της πλεγματοποίησης φαίνεται ξεκάθαρα στην Εικ.(4.15) 
 

5. Έλεγχος πλεγματοποίησης. 
 

i. Απενεργοποιούμε την επιλογή Display of Surfaces 
ii. Ενεργοποιούμε την επιλογή solid & wire κάνοντας δεξί κλικ στην επιλογή 

Shells.(Εικ.(4.14)). 
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Εικόνα 4.14: Γενικές επιλογές ορατότητας αρτηρίας. 
 

 
 

Εικόνα 4.15: Πλεγματοποίηση Octree της αρτηρίας. 
 

6. Εφαρμογή διαδικασίας Cut-planes για έλεγχο πλεγματοποίησης. 
 

Αρχικά επιλέγουμε Wire Frame κάνοντας δεξί κλικ στην επιλογή Shells και στη 
συνέχεια επιλέγουμε Manage Cut Plane. Στο σημείο αυτό εισάγουμε την τιμή 0.95 
για Fraction value και κάνουμε κλικ Apply. Ενεργοποιούμε την επιλογή Volumes 
και Solid & Wire από το ίδιο μενού επιλογών και έπειτα πραγματοποιούμε έλεγχο 
πλεγματοποίησης ως προς τον άξονα x όπως φαίνεται στην Εικ.(4.16). 
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Εικόνα 4.16: Τομή αρτηρίας ύστερα από πλεγματοποίηση Octree, ως προς τον άξονα x. 
 

i. Εισάγουμε Middle X Plane από το μενού επιλογών Method 
ii. Εισάγουμε 0.95 για Fraction Value 
iii. Κάνουμε κλικ Apply. 

 
7. Ομαλοποίηση διαδικασίας πλεγματοποίησης. 

 
Edit Mesh > Smooth Mesh Globally 

 

 
 

Εικόνα 4.17: Ρυθμίσεις ομαλοποίησης της πλεγματοποίησης. 
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Στην Εικ.(4.17) φαίνονται αναλυτικά όλες οι απαραίτητες αλλαγές που πρέπει 

να πραγματοποιηθούν προκειμένου να έχουμε μια επιτυχημένη αλλά και ομαλή 
πλεγματοποίηση ενώ στην Εικ.(4.18) παρατηρούμε τα αποτελέσματα αυτής. 
 

 
 

Εικόνα 4.18: Αποτελέσματα πλεγματοποίησης ύστερα από ομαλοποίηση. 
 

8. Τελικός έλεγχος για πιθανά σφάλματα κατά την πλεγματοποίηση. 
 

Edit Mesh > Check Mesh 
 

 
 

Εικόνα 4.19: Έλεγχος σφαλμάτων πλεγματοποίησης. 
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 Για τον έλεγχο της πλεγματοποίησης που πραγματοποιήθηκε προηγουμένως, 
δεν θα υπάρξουν αλλαγές στις υπάρχουσες ρυθμίσεις που μας παρέχει (Εικ.(4.19)) 
το σύστημα οπότε θα πληκτρολογήσουμε απλά, Apply. 
 
 
 
4.6 Δημιουργία πλεγματοποίησης Delaunay. 
 

1. Αρχικά θα εισάγουμε τις κατάλληλες παραμέτρους πλεγματοποίησης. 
 

Mesh > Global Mesh Setup > Volume Mesh Parameters 
 

 
 

Εικόνα 4.20: Παραμετροποίηση πλεγματοποίησης. 
 

i. Στο αρχικό κελί Mesh Method, εισάγουμε Quick (Delaunay) 
ii. Διατηρούμε τις υπόλοιπες επιλογές ως έχουν και πατάμε Apply. 

 
2. Υπολογισμός της πλεγματοποίησης. 

 
Mesh > Compute Mesh > Volume Mesh 
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Εικόνα 4.21: Πλεγματοποίηση Delaunay. 
 

i. Στη Method list εισάγουμε Quick Delaunay 
ii. Απενεργοποιούμε την επιλογή Create Prism Layers καθώς είναι 

υπολογισμένα από πριν. 
iii. Διατηρούμε τις υπόλοιπες ρυθμίσεις και πατάμε Compute. 

 
3. Έλεγχος πλεγματοποίησης 

 
i. Πλεγματοποίηση εφαρμόζοντας την μέθοδο Cut planes ως προς 

τον άξονα z, όπως φαίνεται και στην Εικ.(4.22). 
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Εικόνα 4.22: Μέθοδος cut plane ως προς τον άξονα z. 
 

ii. Πλεγματοποίηση εφαρμόζοντας την μέθοδο Cut planes ως προς 
τον άξονα x, όπως φαίνεται και στην Εικ.(4.23). 

 

 
 

Εικόνα 4.23: Μέθοδος cut plane ως προς τον άξονα z. 
 

4. Ομαλοποίηση πλεγματοποίησης. 
 

Edit Mesh > Smooth Mesh Globally 
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Εικόνα 4.24: Ρυθμίσεις ομαλοποίησης της πλεγματοποίησης. 
 
 Όλες οι ρυθμίσεις που πρέπει να εισαχθούν ή να τροποποιηθούν φαίνονται 
παραπάνω στην Εικ.(4.24). 
 
 
 
4.7 Καθορισμός επιλυτή και εισαγωγή συνοριακών συνθηκών. 
 

Αρχικά θα αποθηκεύσουμε την εργασία που έχουμε κάνει επιλέγοντας File και 
Save Project as και έπειτα θα καθορίσουμε τον επιλυτή μας με τον τρόπο που 
επιδεικνύεται παρακάτω (Εικ.(4.25)):  
 

i. Επιλέγουμε ANSYS Fluent από τον Output Solver 
ii. Διατηρούμε την επιλογή NASTRAN  από την λίστα Common 

Structural Solver 
iii. Κάνουμε κλικ Apply. 
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Εικόνα 4.25: Επιλογή επιλυτή. 
 

Στο σημείο αυτό θα κάνουμε εισαγωγή συνοριακών συνθηκών, ήτοι: 
 

Output > Boundary Conditions 
 

1. Ορίζουμε τις συνοριακές συνθήκες για την AORTA_WALL στην επιλογή wall. 
 

i. Επιλέγουμε Create New κάτω από την επιλογή AORTA_WALL. 
ii. Εισάγουμε wall στο παράθυρο που εμφανίζεται για την εισαγωγή 

συνοριακών συνθηκών και ύστερα OK. 
iii. Τέλος εισάγουμε Zone ID την τιμή 0 

 
2. Με τον ίδιο ακριβώς τρόπο πραγματοποιείται και η εισαγωγή συνοριακών 

συνθηκών (Εικ.(4.26)) και στα υπόλοιπα τμήματα της αρτηρίας με τη διαφορά 
ότι στο τμήμα INLET θα βάλουμε velocity-inlet ενώ στο τμήμα OUTLET θα 
βάλουμε pressure-outlet.  
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Εικόνα 4.26: Εισαγωγή συνοριακών συνθηκών του τμήματος AORTA_WALL. 
 

3. Τέλος εισάγουμε συνοριακές συνθήκες fluid για το τμήμα FLUID, όπως 
φαίνεται και στην Εικ.(4.27). 

 

 
 

Εικόνα 4.27: Εισαγωγή συνοριακών συνθηκών του τμήματος fluid. 
 

4. Δημιουργία αρχείου εισαγωγής στο πρόγραμμα ANSYS Fluent. 
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Output > Write Input 
 

 
 

Εικόνα 4.28: Ρυθμίσεις σχετικά με τη μορφή αρχείου αποθήκευσης. 
 
 Ύστερα από την πιστή ακολουθία των τροποποιήσεων που υποδεικνύονται 
στην Εικ.(4.28), πατάμε Done. 
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5 ΔΗΜΙΟΥΡΓΙΑ ΠΡΟΒΛΗΜΑΤΟΣ ΚΑΙ ΑΝΑΛΥΣΗΣ ΡΟΗΣ 

ΑΙΜΑΤΟΣ ΕΝΤΟΣ ΑΡΤΗΡΙΑΣ ΜΕ ΣΤΕΝΩΣΗ ( ICEM, 
ANSYS FLUENT) 

 
 
 
 Λόγω της πολυπλοκότητας που μπορεί να παρουσιάσει το πρόγραμμα κατά 
την αντιμετώπιση διαφόρων προβλημάτων, η προσέγγιση του προβλήματος αυτού 
θα πραγματοποιηθεί χωρίζοντάς το σε επιμέρους βήματα. Με την λεπτομερής αυτή 
ανάλυση, επιτυγχάνεται μια ευκολότερη αλλά και γρηγορότερη αντιμετώπιση του 
προβλήματος. 
 
 
 
5.1 Εισαγωγή και σχεδιασμός της γεωμετρίας 
 

Η γεωμετρία του προβλήματος που αναλύουμε, αλλά και γενικότερα σε κάθε 
είδους προβλήματος που ενδέχεται να αντιμετωπίζουμε, μπορεί να δημιουργηθεί ή 
να εισαχθεί στο πρόγραμμα. Η εισαγωγή της γεωμετρίας προϋποθέτει να έχουμε 
στην κατοχή μας το ανάλογο αρχείο γεωμετρίας το οποίο μπορεί να παρέχεται σε 
εμάς από κάποιον αρμόδιο φορέα. Ξεκινάμε το πρόγραμμά μας εισάγοντας το αρχείο 
γεωμετρίας μας επιλέγοντας: File > Import Geometry > STL .Μετά εμφανίζεται ένα 
παράθυρο το οποίο ονομάζεται STL import options, επιλέγουμε την εντολή 
Generate και πατάμε Done. 
 

 
 

Εικόνα 5.1: Γεωμετρία αρτηρίας. 
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Η εισαχθείσα γεωμετρία Εικ.(5.1) περιλαμβάνει ένα μόνο μέρος. Έτσι σε αυτό 
το βήμα θα χωρίσουμε την γεωμετρία Εικ.(5.2) και θα καθορίσουμε τα μέρη αυτά.  
 
 
5.1.1 Χωρισμός της γεωμετρίας  
 

Ο χωρισμός θα γίνει με την επιλογή των ακόλουθων εντολών: 
 

Geometry > Create/Modify Surface > Segment/Trim Surface 
 

 
 

Εικόνα 5.2: Δημιουργία και επεξεργασία επιφάνειας. 
 
Έπειτα επιλέγουμε την εντολή By Angle από την λίστα MethodApply και επιλέγω 
την επιφάνεια της αρτηρίας, για την εντολή Angle θα δώσουμε την τιμή 35 και 
αποδεχόμαστε όλες τις προηγούμενες ενέργειες πατώντας την επιλογή Apply. 
 
 
5.1.2 Δημιουργία εισόδου. 
 

1. Πηγαίνουμε στο αριστερό μέρος του κυρίως προγράμματος. 
2. Στην επιλογή parts πατάμε δεξί click και επιλέγουμε Create Part .Εκεί 

δίνουμε το όνομα inlet. 
3. Διατηρούμε την επιλογή του Create Part by Selection και κάνουμε κλικ στο 

κουμπί Select entities. (Η γραμμή εργαλείων της επιλεγμένης γεωμετρίας 
εμφανίζεται.) 
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4. Επιλέγουμε την επιφάνεια που θα χρησιμοποιήσουμε για είσοδο INLET και 
πατάμε το μεσαίο κουμπί του ποντικιού για να γίνει αποδοχή της επιλογής 
μας. 

5. Στην Εικ.(5.3) απεικονίζεται με μπλε χρώμα η επιφάνεια που επιλέξαμε και 
τέλος, πατάμε την επιλογή apply. 

 

 
 

Εικόνα 5.3: Ορισμός σημείου εισόδου. 
 
5.1.3 Δημιουργία εξόδου 
 

1. Στο Create Part δίνουμε τώρα το όνομα OUTLET. 
2. Διατηρούμε την επιλογή του Create Part by Selection και κάνουμε κλικ στο 

κουμπί Select entities. (Η γραμμή εργαλείων της επιλεγμένης γεωμετρίας 
εμφανίζεται). 

3. Επιλέγουμε την επιφάνεια που θα χρησιμοποιήσουμε για έξοδο outlet και 
πατάμε το μεσαίο κουμπί του ποντικιού μας για αποδοχή των επιλογών. 

4. Tέλος, πατάμε την επιλογή apply. 
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Εικόνα 5.4: Ορισμός σημείου εξόδου 
 
5.1.4 Μετονομασία του αρτηριακού τοιχώματος σε AORTA WALL. 
 

Αυτό θα γίνει πατώντας δεξί κλικ στο Parts και στη συνέχεια Create Part. 
Ύστερα πατάμε αριστερό κλικ και πάμε στην επιλογή RENAME, γράφουμε το νέο 
όνομα AORTA_WALL στην επιλογή NEW NAME και πατάμε Done. Οι επιφάνειες 
που θα επιλέξουμε για τοιχώματα θα είναι όλες πλην της INLET και της OUTLET. 
 
5.1.5 Εξαγωγή καμπύλης από επιφάνειες εισόδου και εξόδου. 
 

Geometry > Create/Modify Curve > Extract Curves from Surfaces 
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Εικόνα 5.5: Δημιουργία και επεξεργασία καμπύλης 
 

1. Από την ενότητα μέρη parts καταργούμε την επιλογή AORTA_WALL 
κάνοντας αριστερό κλικ στην επιλογή AORTA_WALL (Η οθόνη γραφικών 
εμφανίζει μόνο τις επιφάνειες εισόδου και εξόδου.) 

2. Πατάμε κλικ στην επιλογή Select surface και μετά επιλέγουμε  την επιλογή 
(Select all appropriate visible objects).από την γραμμή εργαλείων. 
(Όλες οι επιφάνειες εισόδου και εξόδου θα επιλεγούν) 

3. Ύστερα επιλέγουμε την εντολή Create new από την λίστα Extract edges. 
4. Και τέλος επιλέγουμε την εντολή Apply. 

 
Στη συνέχεια ενεργοποιούμε ξανά την επιλογή AORTA_WALL στην ενότητα 

parts και επιλέγουμε την εντολή WireFrame Simple Display (Εικ.(5.6)). 
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Εικόνα 5.6: Προβολή πλαισίου αρτηρίας. 
 
 
5.2 Δημιουργία του υλικού σημείου 
 

Geometry > Create Body 

 
 

Εικόνα 5.7: Εισαγωγή συνθηκών γεωμετρίας 
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1. Επιλέγουμε την εντολή BLOOD από την επιλογή part. 
2. Διατηρούμε την επιλογή Centroid of 2 points για την εντολή Location 

(Εικ.(5.7)) 
3. Κάνουμε αριστερό κλικ στις δύο θέσεις και μετά, για να δεχτεί την επιλογή 

των σημείων, πατάμε το μεσαίο κουμπί του ποντικιού.  
4. Επιλέγουμε την εντολή Apply. 
5. Επιλέγουμε την εντολή WireFrame Full Display. Περιστρέφοντας την 

γεωμετρία διαπιστώνουμε εάν το νέο υλικό σημείο βρίσκεται μέσα στον 
όγκο. (Εικ.(5.8)). 

6. Και τέλος πατάμε κλικ στην εντολή solid full display για να αποκατασταθεί 
η σκιασμένη επιφάνεια απεικόνισης  

 
 

 
 

Εικόνα 5.8: Δημιουργία υλικού σημείου. 
 
 
 
5.3 Δημιουργία του “Octree Mesh” 
 

Mesh > Global Mesh Setup > Global Mesh Size 
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Εικόνα 5.9: Εισαγωγή παραμέτρων πλεγματοποίησης. 
 

1. Για το Max element εισάγουμε την τιμή 2.5 
2. Επιλέγουμε Enable για τον τομέα Curvature/Proximity Based Refinement 

και εισάγουμε την τιμή 0.5 για το Min size limit. 
3. Βάζουμε την τιμή 10 για το Refinement. 
4. Και επιλέγουμε την εντολή Apply όπως φαίνεται στην Εικ.(5.9). 

 
 
5.3.1 Καθορισμός κομματιών και δημιουργία πρίσματος. 
 

Mesh >Part Mesh Setup 
 

 
 

Εικόνα 5.10: Προβολή κομματιών αρτηρίας. 
 

· Ενεργοποιούμε την επιλογή prism για την AORTA_WALL (Εικ.(5.10)). 
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· Διατηρούμε τις προεπιλεγμένες ρυθμίσεις για τις άλλες παραμέτρους. 
· Κάνουμε κλικ πρώτα στην επιλογή Apply και μετά στην επιλογή 

Dismiss. 
 
 
5.3.2 Εισαγωγή ρυθμίσεων Global Prism 
 

Mesh > Global Mesh Setup > Prism Meshing Parameters 

 
 

Εικόνα 5.11: Εισαγωγή ρυθμίσεων πρίσματος 
 

1. Για το Ortho weight εισάγουμε την τιμή 0.25 
2. Βάζουμε για το Number of volume smoothing steps την τιμή 0 
3. Διατηρούμε τις προεπιλεγμένες ρυθμίσεις για τις άλλες παραμέτρους 

και κάνω κλικ στην επιλογή Apply (Εικ.(5.10)). 
 
 
 
5.4 Ρυθμίσεις πλεγματοποίησης (Mesh) 
 

Mesh > Compute Mesh >Volume Mesh 
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Εικόνα 5.12: Υπολογισμός πλεγματοποίησης 
 

1. Βεβαιωνόμαστε ότι στο Mesh Method έχουμε επιλέξει την επιλογή Robust 
(octree). 

2. Ενεργοποιούμε την εντολή Create Prism Layers. 
3. Και έπειτα πατάμε κλικ στην εντολή Compute. (Εικ.(5.12)) 
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Εικόνα 5.13: Αποτέλεσμα πλεγματοποίησης αρτηρίας. 
 
 
5.4.1 Εξέταση της πλεγματοποίησης (Mesh) μέσω Cut Plane. 
 

1. Πηγαίνοντας πάλι στο mesh βρίσκουμε την εντολή shells και πατώντας δεξί 
κλικ εμφανίζονται κάποιες επιλογές από τις οποίες επιλέγουμε Wire Frame. 

2. Επιλέγουμε την εντολή Manage Cut Plane κάνοντας δεξί κλικ στην εντολή 
Cut Plane και στην συνέχεια την επιλέγουμε: 

3. Τώρα θα ρυθμίσουμε τις ακόλουθες παραμέτρους. 
 

· Διατηρούμε την επιλογή by Coefficients στην αναπτυσσόμενη λίστα 
Method. 

· Στην θέση Fraction Value βάζουμε την τιμή 0.79. 
· Τέλος κάνουμε κλικ στην επιλογή Apply και ενεργοποιούμε την εμφάνιση 

των όγκων (volumes) 
 

4. Πηγαίνουμε ξανά στην εντολή volumes και κάνοντας δεξί κλικ επιλέγουμε την 
εντολή Solid & Wire. 

 
5. Εξετάζουμε το πλέγμα χρησιμοποιώντας ένα επίπεδο τομής στην κατεύθυνση 

Χ. 
· Επιλέγουμε Middle X Plane στην αναπτυσσόμενη λίστα Method . 
· Στην θέση Fraction Value βάζουμε την τιμή 0.79 
· Τέλος κάνουμε κλικ στην επιλογή Apply (Εικ.(5.14)). 
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Εικόνα 5.14: Επίπεδο τομής ως προς τον άξονα Χ. 
 

6. Απενεργοποιούμε την εντολή Show Cut Plane από το Manage Cut Plane 
 
 
5.4.2 Εξομάλυνση (smoothing) του πλέγματος (mesh). 
 

Edit > Smooth Mesh Globally 
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Εικόνα 5.15: Εισαγωγή ρυθμίσεων εξομάλυνσης. 
 

1. Εισάγουμε την τιμή 20 στο Smoothing iteration και την τιμή 0.2 για το Up to 
value. 

2. Στην αναπτυσσόμενη λίστα Criterion διατηρούμε την επιλογή Quality. 
(Εικ.(5.15)) 

3. Διατηρούμε τα υπόλοιπα όπως έχουν και κάνουμε κλικ στην εντολή Apply. 
 

 
 

Εικόνα 5.16: Ιστόγραμμα ποιότητας. 
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5.4.3 Επανέλεγχος διαδικασίας. 
 

Edit Mesh > Mesh Check 
 

 
 

Εικόνα 5.17: Έλεγχος πλεγματοποίησης. 
 

1. Διατηρούμε το προεπιλεγμένο σύνολο των ελέγχων. 
2. Κάνουμε κλικ στην εντολή Apply και ελέγχουμε για τυχόν λάθη και πιθανά 

προβλήματα στο πλέγμα (Εικ.(5.17)). 
 
 
 
5.5 Καθορισμός επιλυτή 
 

1. Επιλέγουμε τον επιλυτή. 
 

Output > Select Solver 
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Εικόνα 5.18: Επιλογή μοντέλου επιλυτή. 
 

· Επιλέγουμε ANSYS Fluent από την αναπτυσσόμενη λίστα Output 
solver. 

· Διατηρούμε την επιλογή NASTRAN από την αναπτυσσόμενη λίστα 
Common Structural Solver (Εικ.(5.18) 

· Τέλος πατάμε κλικ στην επιλογή Apply. 
 
 
5.6 Εισαγωγή προβλήματος και ανάλυσης ροής στο περιβάλλον εργασίας 

του fluent (Ansys workbench) 
 
 Ανεξαρτήτως το πρόβλημα το οποίο μας έχει ανατεθεί να μελετήσουμε και να 
επιλύσουμε, οι εισαγωγικές διαδικασίες που πρέπει να ακολουθήσουμε και οι 
εισαγωγικές ρυθμίσεις που πρέπει να δώσουμε παρουσιάζουν σημαντικές ομοιότητες 
μεταξύ τους. 
 

1. Βήμα πρώτο: 
 
 Αρχικά ανοίγουμε το πρόγραμμα “AnsysWorkbench” που βρίσκεται στην 
επιφάνεια εργασίας του υπολογιστή μας μετά την εγκατάσταση όλου του λογισμικού 
και στη συνέχεια εισερχόμαστε στο περιβάλλον εργασίας του. Επιλέγουμε “Fluid 
Flow (FLUENT)” και δίνουμε τίτλο στο πρόβλημα μας όπως φαίνεται και στην 
Εικ.(5.19). 
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Εικόνα 5.19: Εισαγωγή ανάλυσης ροής και ονομασία προβλήματος. 
 

2. Βήμα δεύτερο: 
 
 Στο βήμα αυτό θα ενεργοποιήσουμε την επιλογή “Files” από την καρτέλα 
“View” προκειμένου να έχουμε πλήρης εικόνα των αρχείων που χρησιμοποιούνται 
στην ανάλυση αυτή όπως παρατηρείται και στην Εικ.(5.20). Η τοποθεσία όπου θα 
επιλέξουμε να αποθηκεύσουμε την ανάλυση αυτή επιλέγεται ανάλογα με τις 
προτιμήσεις του χρήστη. 
 

 
 

Εικόνα 5.20: Προβολή αρχείων ανάλυσης ροής. 
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5.7 Εισαγωγή αρχείου πλεγματοποίησης στο ANSYS Workbench 
 
 Έχοντας στην κατοχή μας το αρχείο πλεγματοποίησης της αρτηρίας που 
αναλύουμε, θα ακολουθήσουμε στην διαδικασία εισαγωγής αυτού, στο λογισμικό 
“ANSYS Fluent Workbench”. 
 

1. Βήμα πρώτο: 
 
 Κάνοντας δεξί κλικ στην επιλογή “Mesh”, από το περιβάλλον εργασίας του 
προγράμματος, επιλέγουμε “Import Mesh File” και στη συνέχεια εξερευνούμε τα 
αρχεία του υπολογιστή μας επιλέγοντας “Browse” έως ότου βρούμε το αρχείο 
πλεγματοποίησης που αναζητάμε. Στην Εικ.(5.21) υποδεικνύεται όλη η παραπάνω 
διαδικασία προκειμένου να αποφευχθούν τυχόν σφάλματα. 
 

 
 
Εικόνα 5.21: Εισαγωγή αρχείου πλεγματοποίησης της αρτηρίας στο “ANSYS Fluent Workbench”. 

 
2. Βήμα δεύτερο: 

 
 Φθάνοντας στο σημείο που φαίνεται στην Εικ.(5.22), σημαίνει ότι έχουμε 
ακολουθήσει σωστά την διαδικασία εισαγωγής πλεγματοποίησης καθώς το αρχείο 
που επιλέξαμε έχει γίνει αποδεκτό από το πρόγραμμα. 
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Εικόνα 5.22: Απεικόνιση επιτυχημένης εισαγωγής αρχείου πλεγματοποίησης.  
 
 
5.8 Προσομοίωση αρτηρίας χρησιμοποιώντας την εφαρμογή Ansys Fluent 
 
 Ύστερα από την επιτυχημένη εισαγωγή του αρχείου πλεγματοποίησης της 
αρτηρίας, θα πραγματοποιηθεί μια υπολογιστική ρευστοδυναμική ανάλυση (CFD). Η 
ανάλυση αυτή επιτυγχάνεται χρησιμοποιώντας την εφαρμογή “ANSYS Fluent” που 
βρίσκεται στο περιβάλλον εργασίας “Workbench” και εξετάζεται στα παρακάτω 
βήματα. 
 

1. Βήμα πρώτο: 
 
 Θέτοντας σε λειτουργία την εφαρμογή “ANSYS Fluent” από το περιβάλλον 
εργασίας “ANSYS Workbench”, εμφανίζεται στην οθόνη μας το πρόγραμμα 
“ANSYS Launcher” μέσω του οποίου μπορούμε να δώσουμε κάποιες εισαγωγικές 
ρυθμίσεις βασιζόμενες στις προτιμήσεις του χρήστη. Στην προκειμένη περίπτωση 
δεν χρειάζεται να αλλάξουμε καμία ρύθμιση οπότε συνεχίζουμε την φόρτωση της 
εφαρμογής κλείνοντας το πρόγραμμα “ANSYS Launcher”. 
 

2. Βήμα δεύτερο: 
 
 Έχοντας πραγματοποιήσει επιτυχημένη εκκίνηση του “ANSYS Fluent”, 
προτεραιότητα έχει, ο καθορισμός των μονάδων με τις οποίες θα γίνεται η μελέτη της 
ροής εντός της αρτηρίας. Η μονάδες μήκους με τις οποίες θα εργαστούμε στο 
πρόγραμμα αυτό θα είναι χιλιοστά (mm) και ο τρόπος με τον οποίο πραγματοποιείται 
ο καθορισμός αυτός, υποδεικνύεται αναλυτικά στην Εικ.(5.23). 
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Εικόνα 5.23: Εισαγωγή μονάδων μέτρησης μήκους. 
 
 Στο σημείο αυτό είναι συνετό να πραγματοποιήσουμε ένα έλεγχο 
πλεγματοποίησης, όπως φαίνεται στην Εικ.(5.24), προκειμένου να εξετάσουμε την 
υπολογιστική ικανότητα της πλατφόρμας μας. 
 

 
 

Εικόνα 5.24: Έλεγχος πλεγματοποίησης στο “ΑNSYS Fluent ”. 
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3. Βήμα τρίτο: 
 
 Στο βήμα αυτό θα μοντελοποιήσουμε την προσομοίωσή μας επιλέγοντας 
“Models” από την λίστα επιλογών στα αριστερά. Αρχικά ενεργοποιούμε τις 
επιλογές“Energy Equation” και “k-epsilon (2eqn)” και στη συνέχεια τις επιλογές 
“Standard” και “Enhanced Wall Treatment” όπως ακριβώς υποδεικνύεται στην 
Εικ.(5.25) . Με αυτό τον τρόπο επιτυγχάνεται μια πιο απλή επεξεργασία και μελέτη 
των αποτελεσμάτων της προσομοίωσης αυτής. 
 

 
 

Εικόνα 5.25: Ρυθμίσεις μοντελοποίησης και προσομοίωσης της ροής. 
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4. Βήμα τέταρτο: 
 
 Στο σημείο αυτό επιλέγουμε “Materials ~ Fluid ~ Create/Edit…” έτσι ώστε να 
καθορίσουμε τα υλικά στοιχεία που θα χρησιμοποιηθούν κατά την ανάλυση αυτής της 
ροής. Στο μενού με τις επιλογές που εμφανίζεται, πραγματοποιούμε ορισμένες 
αλλαγές. Στην Εικ.(5.26) παρατηρούνται αναλυτικά οι αλλαγές αυτές οι οποίες 
λαμβάνουν χώρα. 
 

 
 

Εικόνα 5.26: Καθορισμός στοιχείου (blood) για τη μελέτη της ροής αίματος και εισαγωγή τιμών σε 
βασικές παραμέτρους. 

 
 Αρχικά παρατηρούμε ότι ορίζεται το αίμα σαν το ρευστό που θα 
χρησιμοποιηθεί προκειμένου να επιτευχθεί η μελέτη ροής εντός της συγκεκριμένης 
αρτηρίας. Στη συνέχεια απαιτείται ο καθορισμός ορισμένων παραμέτρων όπου θα 
χαρακτηρίζουν του ρευστό αυτό, όπως παρουσιάζεται στην Εικ.(5.26). 
 

5. Βήμα πέμπτο: 
 
 Ύστερα από την επιτυχημένη ολοκλήρωση των παραπάνω επεξεργασιών, 
είναι σημαντικό να διαμορφώσουμε τις οριακές συνθήκες των κελιών. Εισερχόμαστε 
λοιπόν στο μενού επεξεργασίας των οριακών συνθηκών και πραγματοποιούμε 
ορισμένες τροποποιήσεις όπως προβάλλεται στην Εικ.(5.27). 
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Εικόνα 5.27: Επεξεργασία συνοριακών συνθηκών (inlet) 
 
 Σε αυτό το σημείο είναι σημαντικό να αναφερθεί, πως οι τιμές εισάγονται 
ανάλογα με τις προτιμήσεις του χρήστη και τους πειραματισμούς που επιθυμεί να 
πραγματοποιήσει. Σε αυτήν την περίπτωση, οι τιμές που επιλέγουμε απεικονίζονται 
στις παραπάνω εικόνες. 
 

6. Βήμα έκτο: 
 
 Σε αυτό το βήμα δίνουμε ιδιαίτερη προσοχή καθώς ο τρόπος με τον οποίο 
επιτυγχάνεται ο προσδιορισμός των συνοριακών συνθηκών είναι πολύ σημαντικός 
για την μετέπειτα πορεία της μελέτης μας. 
 Αρχικά επιλέγουμε “Boundary Conditions” από το μενού στα αριστερά και 
στην συνέχεια επιλέγουμε την επιφάνεια με όνομα “outlet” ούτως ώστε να 
εισάγουμε ορισμένες ρυθμίσεις. Στην Εικ.(5.28) παρατηρείται ολόκληρη η παραπάνω 
διαδικασία καθώς και όλες οι αλλαγές που πρέπει να πραγματοποιηθούν. 
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Εικόνα 5.28: Επεξεργασία συνοριακών συνθηκών (outlet) 
 
 

7. Βήμα έβδομο: 
 
 Ολοκληρώνοντας με επιτυχία τα παραπάνω βήματα, είμαστε πλέον έτοιμοι να 
προετοιμάσουμε τον επιλυτή που θα χρησιμοποιήσουμε, προκειμένου να επιτευχθεί 
η υπολογιστική ρευστοδυναμική προσομοίωση της ροής μας. Αρχικά επιλέγουμε 
“Monitors ~ Residuals ~ Edit…” από το μενού στα αριστερά και στη συνέχεια 
πραγματοποιούμε ορισμένες τροποποιήσεις με τον τρόπο που υποδεικνύεται στην 
Εικ.(5.29). 
 



[85] 

 
 

Εικόνα 5.29: Ρυθμίσεις επιλυτή.  
 

 
 Αφού έχουν πραγματοποιηθεί οι τροποποιήσεις που φαίνονται στην 
Εικ.(5.29), σειρά έχει η δημιουργία ενός ανιχνευτή για την επιφάνεια εξόδου της 
αρτηρίας. Οι αλλαγές που λαμβάνουν χώρα είναι: 
 

· Ενεργοποίηση επιλογής “Plot”. 
· “Get Data Every” :3. Με αυτόν τον τρόπο γίνεται καταγραφή των δεδομένων 

μετά από κάθε τρείς επαναλήψεις. 
· Επιλέγουμε “Mass-Weighted Average”. 
· Επιλέγουμε “Temperature” και “Static Temperature 
· Ορίζουμε “Pressure-Outlet” στο κελί “Surfaces” και πατάμε “OK”  

 
Στην Εικ.(5.30) φαίνονται όλες οι παραπάνω τροποποιήσεις σχετικά με την επιλογή 
“Surface monitors”, αναλυτικά. 
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Εικόνα 5.30: Εισαγωγή ρυθμίσεων στον παρακολουθητή επιφανειών. 
 
 Πλησιάζοντας προς το τέλος του βήματος αυτού, αλλάζουμε ορισμένες 
μεθόδους επίλυσης του προβλήματος που επεξεργαζόμαστε. Στην Εικ.(5.31) 
απεικονίζονται όλες αυτές οι αλλαγές. 
 

 
 

Εικόνα 5.31: Μέθοδοι επίλυσης της ρευστοδυναμικής ανάλυσης. 
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8. Βήμα όγδοο: 
 
 Ύστερα από την επιτευγμένη εφαρμογή των ρυθμίσεων που αναλύονται σε 
όλα τα παραπάνω βήματα, ξεκινάμε την διαδικασία προσδιορισμού επίλυσης του 
προβλήματος. Στο μενού “Run Calculation” στα αριστερά, εισάγουμε έναν αριθμό 
στη θέση “Number of Iterations” όπου θα αντιπροσωπεύει τον αριθμό 
επαναλήψεων επίλυσης του προβλήματος. Ο αριθμός που επιλέγουμε είναι σχετικά 
μικρός καθώς η ακρίβεια επίλυσης δεν διαφοροποιείται ύστερα από την 
πραγματοποίηση πολλαπλών επαναλήψεων. Η διαδικασία στη οποία αναφερόμαστε, 
προβάλλεται στην Εικ.(5.32). Τέλος, κλείνουμε την εφαρμογή “ANSYS Fluent” και 
μελετάμε τα αποτελέσματα. 
 

 
 

Εικόνα 5.32: Επίλυση της υπολογιστικής ρευστοδυναμικής ανάλυσης. 
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6 ΣΥΜΠΕΡΑΣΜΑΤΑ 
 
 
 
6.1 Αποτελέσματα υπολογιστικής και ρευστοδυναμικής ανάλυσης. 
 
 Αρχικά θα εξετάσουμε τα αποτελέσματα της υπολογιστικής και 
ρευστοδυναμικής ανάλυσης που πραγματοποιήθηκε στο υποκεφάλαιο (5.8) και στη 
συνέχεια θα δοθεί σημασία στα μεγέθη τα οποία μεταβάλλονται εντός της αρτηρίας, 
ξεχωριστά. 
 Στην Εικ.(5.33), συμπεραίνουμε οτι η συμπεριφορά της ταχύτητας ως προς 
τους άξονες x,y,z καθώς και η μεταβολή διαφόρων άλλων μεγεθών (ενέργεια) κατά 
την διαδικασία επανάληψης της μεθόδου επίλυσης, συγκλίνει. Ο βαθμός σύγκλισης 
της λύσης ο οποίος παρατηρείται, σημαίνει ότι το κριτήριο σύγκλισης για κάθε 
μεταβλητή ξεχωριστά έχει επιτευχθεί. Επίσης παρατηρείται, ότι μετά από τις 100 
επαναλήψεις, η λύση παρουσιάζει γραμμικότητα. Αυτό συμβαίνει διότι η ακρίβεια της 
λύσης αυξάνεται σημαντικά και οι διαφορές των αποτελεσμάτων γίνονται πιο μικρές. 
 

 
 

Εικόνα 6.1: Αποτελέσματα επίλυσης της ρευστοδυναμικής ανάλυσης. 
 
 
 
6.2  Μελέτη αποτελεσμάτων στατικής πίεσης. 
 

Στην Εικ.(5.34) παρατηρούμε τον τρόπο με τον οποίο μεταβάλλεται η στατική 
πίεση κατά μήκους της αρτηρίας που μελετάμε. Συμπεραίνουμε πως η διαφορά αυτή 
της πίεσης στην είσοδο και στην έξοδο, οφείλεται στην αλλαγή της διατομής της 
αρτηρίας καθώς και στις στενώσεις της. Οι τιμές της στατικής πίεσης είναι ανάλογες 
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με τις τιμές της διαμέτρου, όσο πιο μικρή διάμετρο έχουμε τόσο πιο μικρή στατική 
πίεση παρουσιάζεται εντός της αρτηρίας. 

Οι μέγιστες και ελάχιστες τιμές που παίρνει είναι οι εξής: 
 

· Min: -33666 Pa 
· Max:43882 Pa 

 
 

 
 

Εικόνα 6.2: Κατανομή στατικής πίεσης. 
 
 
 
6.3 Μελέτη αποτελεσμάτων ταχύτητας ροής. 
 

Η κατανομή της ταχύτητας κατά μήκος της αρτηρίας απεικονίζεται στην 
Εικ.(5.35). Παρατηρούμε πως η ταχύτητα κατά μήκος της αρτηρίας είναι ίδια. 
Ωστόσο, υπάρχουν διαφοροποιήσεις στα σημεία των στενώσεων καθώς έχουμε 
απότομη αλλαγή διατομής. Αυτό έχει σαν αποτέλεσμα την αύξηση της δυναμικής, την 
μείωση της στατικής πίεσης και τελικά, στην δημιουργία αθηρωματικής πλάκας. 

Οι μέγιστες καθώς και οι ελάχιστες τιμές που παίρνει η ταχύτητα, προβάλλονται 
παρακάτω : 
 

· Min: 0 
· Max:10.2 m/s 
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Εικόνα 6.3: Κατανομή ταχύτητας. 
 
 
 
6.4 Μελέτη αποτελεσμάτων κατανομής θερμοκρασίας. 
 

Στην Εικ.(5.36) είναι δυνατόν να παρατηρηθεί η κατανομή της θερμοκρασίας 
κατά μήκος της αρτηρίας. Παρατηρούμε πως υπάρχει πτώση της θερμοκρασίας στα 
σημεία των στενώσεων και στο μεγαλύτερο μέρος της εξόδου. Αυτό συμβαίνει λόγο 
των εσωτερικών τριβών που αναπτύσσονται μεταξύ των τοιχωμάτων και του ρευστού 
στο σημείο  της στένωσης. 

Οι μέγιστες καθώς και οι ελάχιστες τιμές που παίρνει η θερμοκρασία, είναι οι εξής: 
 

· Min: 299.88 Κ 
· Max:309.6 Κ 
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Εικόνα 6.4: Κατανομή θερμοκρασίας. 
 
 
 
6.5 Μελέτη αποτελεσμάτων διατμητικών τάσεων. 
 

Τέλος, παρατηρώντας την Εικ.(5.37) συμπεραίνουμε ότι η διατμητική τάση 
παίρνει μέγιστες τιμές στα σημεία όπου παρατηρείται και απότομη μείωση της 
διατομής της, δηλαδή τις στενώσεις. Επίσης σημαντικό θα ήταν να αναφέρουμε ότι 
μετά την στένωση παρουσιάζονται χαμηλότερες τοιχωματικές διατμητικές τάσεις, 
αυτό οφείλεται στις ρευστοδυναμικές συνθήκες που επικρατούν μετά την στένωση 
λόγο μιας ζώνης ανακυκλοφορίας που δημιουργείται στην περιοχή. Η ζώνη 
ανακυκλοφορίας που δημιουργείται ευνοεί την περαιτέρω ανάπτυξη της 
αθηρωματικής πλάκας στα τοιχώματα της αρτηρίας. Το μέγεθος της τοιχωματικής 
διατμητικής τάσης είναι αλληλένδετο με την αύξηση της ταχύτητας του αίματος από 
τα τοιχώματα της αρτηρίας προς το κέντρο της.  

Παρακάτω φαίνονται οι μέγιστες καθώς και οι ελάχιστες τιμές των διατμητικών 
τάσεων. 
 

· Min: 0 Pa 
· Max:2321,5 Pa 
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Εικόνα 6.5: Κατανομή διατμητικών τάσεων. 
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